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1 Preface

1.1 About this Manual

This user manual provides all the information specific to the digital standard
IEEE 802.11.

All general instrument functions and settings common to all applications and operating
modes are described in the main R&S SMW user manual.

The main focus of this manual is on the provided settings and the tasks required to
generate a signal. The following topics are included:
● Welcome to the IEEE 802.11 options R&S SMW-K54/-K86

Introduction to and getting familiar with the option
● About the IEEE 802.11 and Basics

Background information on basic terms and principles in the context of the signal
generation

● IEEE 802.11 Configuration and Settings
A concise description of all functions and settings available to configure signal gen-
eration with their corresponding remote control commands

● Remote Control Commands
Remote commands required to configure and perform signal generation in a
remote environment, sorted by tasks
(Commands required to set up the instrument or to perform common tasks on the
instrument are provided in the main R&S SMW user manual)

● List of remote commands
Alphabetical list of all remote commands described in the manual

● Index

1.2 Documentation Overview

The user documentation for the R&S SMW consists of the following parts:

● Getting Started printed manual
● Online Help system on the instrument, incl. Tutorials
● Documentation CD-ROM with:

– Getting Started
– Online help system (Web Help and *.chm) as a standalone help

– User Manuals for base unit and options
– Service manual
– Data sheet and product brochure
– Links to useful sites on the Rohde & Schwarz internet

 

 

 

Documentation Overview
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Online Help

The Online Help is embedded in the software. It offers quick, context-sensitive access
to the complete information needed for operation and programming. The online help
contains help on operating the R&S SMW and all available options.

Getting Started

The Getting Started is delivered with the instrument in printed form and in PDF format
on the documentation CD. It provides the information needed to set up and start work-
ing with the instrument. Basic operations and typical signal generation examples are
described. Safety information is also included.

This manual is available in several languages. You can download these documents
from the Rohde & Schwarz website, on the R&S SMW product page at http://
www.rohde-schwarz.com/product/SMW200A.html > Downloads > Manuals.

User Manual

User manuals are provided for the base unit and each additional (software) option.

The User Manual for the base unit is a supplement to the Getting Started manual and
provides basic information on operating the R&S SMW in general. In this manual, all
instrument functions are described in detail. Furthermore, it provides a complete
description of the remote control commands with programming examples. An introduc-
tion to remote control is provided, as well as information on maintenance, instrument
interfaces and troubleshooting.

In the user manuals for the individual software options, the specific instrument func-
tions of this option are described in detail. For additional information on default settings
and parameters, refer to the data sheets. Basic information on operating the
R&S SMW is not included in these user manuals.

The user manuals are available in PDF format - in printable form - on the Documenta-
tion CD-ROM delivered with the instrument.

All user manuals are also available for download from the Rohde & Schwarz website,
on the R&S SMW product page at http://www.rohde-schwarz.com/product/
SMW200A.html > Downloads > Manuals.

Service Manual

The service manual is available in PDF format on the CD delivered with the instrument.
It describes how to check compliance with rated specifications, instrument function,
repair, troubleshooting and fault elimination. It contains all information required for
repairing the R&S SMW by replacing modules.

Release Notes

The release notes describe the installation of the firmware, new and modified func-
tions, eliminated problems, and last minute changes to the documentation. The corre-
sponding firmware version is indicated on the title page of the release notes.

The latest versions are available for download from the R&S SMW product page, at
http://www.rohde-schwarz.com/product/SMW200A.html > Downloads > Firmware.

Documentation Overview

http://www.rohde-schwarz.com/product/SMW200A.html
http://www.rohde-schwarz.com/product/SMW200A.html
http://www.rohde-schwarz.com/product/SMW200A.html
http://www.rohde-schwarz.com/product/SMW200A.html
http://www.rohde-schwarz.com/product/SMW200A.html


PrefaceR&S®SMW-K54/-K86

9User Manual 1175.6749.02 ─ 08

Web Help

The web help provides online access to the complete information on operating the
R&S SMW and all available options, without downloading. The content of the Web
Help corresponds to the user manuals for the latest product version.

The web help is available from the R&S SMW product page, at http://www.rohde-
schwarz.com/product/SMW200A.html > Downloads > Web Help.

Tutorials

A set of tutorials is embedded in the software. The tutorials offer guided examples and
demonstrations on operating the R&S SMW.

Application Notes

Application notes, application cards, white papers and educational notes are further
publications that provide more comprehensive descriptions and background informa-
tion.

A subset of application notes is provided on the documentation CD-ROM delivered
with the instrument.

The latest versions are available for download from the Rohde & Schwarz website, at
http://www.rohde-schwarz.com/appnotes.

1.3 Conventions Used in the Documentation

1.3.1 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such as
dialog boxes, menus, options, buttons, and softkeys are enclosed by
quotation marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are distin-
guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.

 

 

Conventions Used in the Documentation
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1.3.2 Conventions for Procedure Descriptions

When describing how to operate the instrument, several alternative methods may be
available to perform the same task. In this case, the procedure using the touchscreen
is described. Any elements that can be activated by touching can also be clicked using
an additionally connected mouse. The alternative procedure using the keys on the
instrument or the on-screen keyboard is only described if it deviates from the standard
operating procedures.

The term "select" may refer to any of the described methods, i.e. using a finger on the
touchscreen, a mouse pointer in the display, or a key on the instrument or on a key-
board.

1.3.3 Notes on Screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as much as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic test situations.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

 

 

Conventions Used in the Documentation
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2 Welcome to the IEEE 802.11 WLAN Digital
Standard
The R&S SMW-K54/-K86 are a firmware applications that add functionality to generate
signals in accordance with the Wireless LAN standards IEEE 802.11a/b/g/n/ac/p/j.

The option R&S SMW-K54 offers signal generation according to IEEE 802.11n, addi-
tionally legacy modes of IEEE 802.11a/b/g and IEEE 802.11p/j are supported. For
IEEE 802.11ac signal generation option R&S SMW-K86 is required. At least one
R&S SMW-K54 option must be installed on the respective instrument as a prerequisite.

The R&S SMW supports all mandatory and almost all optional features of the
IEEE 802.11 standard.

The following list gives an overview of the main features:
● Support of up to eight Tx antennas
● 20 MHz and 40 MHz
● 80 MHz and 160 MHz bandwidth with option R&S SMW-K86
● Support of all three operation modes (Legacy, Mixed Mode, Green Field)
● Support of all legacy transmission modes (L-10 MHz, L-20 MHz, L-Duplicate, L-

Upper, L-Lower)
● Support of all 11n transmission modes (HT-20 MHz, HT-40 MHz, HT-Duplicate,

HT-Upper, HT-Lower)
● Support of all 11ac transmission modes with option R&S SMW-K86 (VHT-20 MHz,

VHT-40 MHz, VHT-80 MHz, VHT-80+80 MHz, VHT-160 MHz)
● Additional support of the CCK and PBCC frames in accordance with

IEEE 820.11a/b/g standard
● Support of STBC (Space Time Block Coding) and Spatial Multiplexing
● Up to 8 spatial streams in all supported channel widths
● Multi User MIMO available with 2 or more total spatial streams
● Configurable number of spatial streams, space time streams and additional spatial

streams, as well as configurable modulation per spatial stream
● Support of short guard interval
● Configurable state of the scramble, interleaver, time domain windowing and chan-

nel coding
● Configurable PPDU, MAC header and FCS
● Integrated frame block concept for the generation of sequence of cascaded frame

blocks with different configurations and data rates
● Support of simple diversity and MIMO tests (Frequency Flat MIMO channel simula-

tion) without additional channel simulator
● Simulation of real-time MIMO channel condition for instruments equipped with the

fading options R&S SMW-K74/-B14(x2)

This user manual contains a description of the functionality that the application pro-
vides, including remote control operation.
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All functions not discussed in this manual are the same as in the base unit and are
described in the R&S SMW user manual. The latest version is available for download
at the product homepage.

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMW Service Manual.

2.1 Accessing the IEEE 802.11 WLAN Dialog

To open the dialog with IEEE 802.11 WLAN settings

► In the block diagram of the R&S SMW, select "Baseband > IEEE 802.11".

A dialog box opens that displays the provided general settings.

The signal generation is not started immediately. To start signal generation with the
default settings, select "State > On".

2.2 Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, this includes:
● Managing settings and data lists, i.e. storing and loading settings, creating and

accessing data lists, accessing files in a particular directory, etc.
● Information on regular trigger, marker and clock signals as well as filter settings, if

appropriate.
● General instrument configuration, such as checking the system configuration, con-

figuring networks and remote operation
● Using the common status registers

For a description of such tasks, see the R&S SMW user manual.

 

 

Scope
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3 About IEEE 802.11 WLAN and Basics
IEEE 802.11n is the extension of the WLAN IEEE 802.11a/g standard to nominal peak
data rates of 600 Mbps. Like IEEE 802.11a/g, IEEE 802.11n is also based on OFDM.
Additionally, IEEE 802.11n uses MIMO technology, up to 40 MHz bandwidth and spe-
cial coding for increased throughput. The extension towards higher data rates is also
known as high throughput mode (HT mode) of 802.11n, whereas the non-HT mode
can be seen as the part of 802.11n, which is backwards compatible to 802.11a/g.

IEEE 802.11p is another extension to the WLAN IEEE 802.11a/g standard for the
usage of wireless access in vehicular environment, e.g. Car-to-Car (C2C)/ Vehicle-
toVehicle (V2V), intelligent transport systems(ITS).

IEEE 802.11ac further extends 802.11n to nominal peak data rates of 6240.0 Mbps.
Like IEEE 802.11a/g/n, IEEE 802.11ac is also based on OFDM. Additionally, IEE 
802.11ac uses MIMO technology, up to 160 MHz bandwidth and special coding for
increased throughput. The extension towards higher data rates is also known as very
high throughput (VHT) mode of 802.11ac.

3.1 Operation Modes

The IEEE 802.11n standard defined the following three operation modes:
● Legacy mode

This mode is provided for backwards compatibility with the IEEE 802. a/g standard.
The mode is also known as Non-HT mode.

● Mixed Mode
A legacy preamble and header (L-STF, L-LTF and L-SIG) are wrapping the HT part
of the frame so that the frame is complying with OFDM-PHY and ERP-OFDM-PHY
corresponding to 802.11 a/g respectively.

● Green Field
In this mode, frames are being transmitted in a new high throughput format that
does not comply with the legacy mode. Green Field is an optional mode.

The Figure 3-1 shows the packet formats of the different operation modes that can be
triggered by a device supporting the IEEE 802.11n standard.

Figure 3-1: PLCP Packet format for IEEE 802.11

 

 

Operation Modes
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The Table 3-1 gives an overview of the frequency domain operation modes of the
physical layer. Note that the duplicate mode corresponds to repeating the same com-
plex numbers modulating the sub-carriers of the upper channel on the lower channel.

Table 3-1: Frequency Domain PHY Operation

LM Legacy mode as in IEEE 802.11a/g

Additionally the CCK and the PBCC frames as in IEEE 802.11b/g

HT-Mode Frequency: 20 MHz and 40 MHz, 1...4 spatial streams (HT Duplicate Mode
included)

Duplicate Non-HT Mode IEEE 802.11a OFDM-PHY format, 20 MHz and 40 MHz dual operation, upper
channel rotated by 90˚ relative to lower channel

Upper Mode Non-HT/HT frame in the upper 20 MHz channel

Lower Mode Non-HT/HT frame in the lower 20 MHz channel

VHT-Mode Frequency 20 MHz, 40 MHz, 80 MHz, 160 MHz, 1...8 spatial streams (option
R&S SMW-K86 required)

When operating in the OFDM 20 MHz mode, there are 64 sub-carriers available; the
migration to 40 MHz mode offers 128 sub-carriers with the same frequency spacing of
312.5 KHz. 80 MHz bandwidth is using 256 sub-carriers, keeping the original fre-
quency spacing. With 160 MHz bandwidth 512 sub-carriers apply.

3.2 Signal Generation

The generation of an IEEE 802.11n/ac signal is done in multiple steps. In high through-
put (HT) and very high throughput (VHT) modes, the data of a single user is specially
coded and transmitted via up to eight Tx antennas.

In this implementation, the mapping of the Tx antennas' signals to the output paths of
the instrument can be configured. This function can be used for the simulation of fre-
quency flat MIMO channel, i.e. one carrier analysis like BER tests for instance. Another
application of these configurable mapping is the possibility to generate a combined sig-
nal from different antennas in case of one path instrument or limited number of base-
band paths.

Refer to Figure 3-2 for an overview of the signal flow for generation of such a signal in
HT mode.

 

Signal Generation
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Figure 3-2: IEEE 802.11 n/ac Transmission chain

Signal Generation
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4 WLAN Configuration and Settings
► To access the IEEE 802.11 WLAN settings, select "Baseband > IEEE 802.11

WLAN".

The remote commands required to define these settings are described in Chapter 6,
"Remote-Control Commands", on page 85.

● General Settings..................................................................................................... 16
● Trigger Settings.......................................................................................................20
● Marker Settings.......................................................................................................25
● Clock Settings......................................................................................................... 30
● Local and Global Connector Settings......................................................................31
● Frame Block Configuration......................................................................................32
● Transmit Antenna Setup......................................................................................... 37
● PPDU Configuration................................................................................................39
● A-MPDU Settings....................................................................................................48
● Data Settings...........................................................................................................49
● MAC Header and FCS Configuration for Frame Block........................................... 54
● MAC Header HT and VHT Configuration................................................................63
● Spatial Mapping...................................................................................................... 70
● Filter / Clipping Settings.......................................................................................... 73

4.1 General Settings

This dialog provides access to the default and the "Save/Recall" settings, and displays
the sample rate.

 

 

General Settings



WLAN Configuration and SettingsR&S®SMW-K54/-K86

17User Manual 1175.6749.02 ─ 08

► To access this dialog select "Baseband > IEEE 802.11 WLAN > General".

This tab comprises the standard general settings.

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Remote command: 
[:SOURce<hw>]:BB:WLNN:STATe on page 89

Set to Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Parameter Value

General Parameters  

State Not affected by "Set to Default"

Transmission Bandwidth 20 MHz

Configure Baseband B from Baseband A Off

Tx Antennas 1

Filter Cosine

Clipping Off

Frame Blocks Configuration  

Frame Blocks 1

Frame Block Type DATA

General Settings
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Parameter Value

Frame Blocks State On

Physical Mode MIXED MODE

Tx Mode HT-20 MHz

Frames 1

Idle Time 0.1 ms

Data Source PN9

TX Antenna Setup  

Antennas 1

Mapping Coordinates Cartesian

Output First set Baseband, rest is set to Off

Matrix Elements (Real, Imaginary, Magnitude,
Phase)

All zero but diagonal = 1

PPDU Configuration  

Spatial Streams 1

Space Time Streams 1

Extended Spatial Streams 0

Space Time Block Coding inactive

Parameter Value  

MCS 1

Data Rate (Mbps) 13

Data Bits Per Symbol 52

Stream 1 QPSK

Channel Coding BCC

Coding Rate ½

Guard Long

Data Length 1024 bytes

Number of Data Symbols 158

Scrambler ON (User Init)

Scrambler Init 01

Interleaver Active ON

Service Field 0000

Time Domain Windowing Active On

Transition Time 100 ns

Preamble/Header Active ON

General Settings



WLAN Configuration and SettingsR&S®SMW-K54/-K86

19User Manual 1175.6749.02 ─ 08

Parameter Value

Smoothing ON

Spatial Mapping  

Mode Spatial Expansion

Index k 20

Remote command: 
[:SOURce<hw>]:BB:WLNN:PRESet on page 87

Save/Recall
Accesses the "Save/Recall" dialog, i.e. the standard instrument function for storing and
recalling the complete dialog related settings in a file. The provided navigation possibil-
ities in the dialog are self-explanatory.

The file name and the directory it is stored in are user-definable; the file extension is
however predefined.

See also, chapter "File and Data Management" in the R&S SMW User Manual.

Remote command: 
[:SOURce<hw>]:BB:WLNN:SETTing:CATalog? on page 88
[:SOURce<hw>]:BB:WLNN:SETTing:LOAD on page 88
[:SOURce<hw>]:BB:WLNN:SETTing:STORe on page 89
[:SOURce<hw>]:BB:WLNN:SETTing:DELete on page 88

Generate Waveform File
With enabled signal generation, triggers the instrument to store the current settings as
an ARB signal in a waveform file. Waveform files can be further processed by the ARB
and/or as a multi carrier or a multi segment signal.

The file name and the directory it is stored in are user-definable; the predefined file
extension for waveform files is *.wv.

Remote command: 
[:SOURce<hw>]:BB:WLNN:WAVeform:CREate on page 89

Transmission Bandwidth
Selects the transmission bandwidth.

If the system bandwidth is set to 20 MHz, all invalid configurations in the frame blocks
table are set to the default values.

Remote command: 
[:SOURce<hw>]:BB:WLNN:BWidth on page 86

Sample Rate
Displays the sample rate of the signal specific for the selected bandwidth.

Remote command: 
[:SOURce<hw>]:BB:WLNN:SRATe? on page 94

Transmit Antennas Setup
Acesses the dialog for configuring the TX antennas.

General Settings
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The menu is described in Chapter 4.7, "Transmit Antenna Setup", on page 37.

Remote command: 
n.a.

Filter / Clipping Settings
Accesses the dialog for setting baseband filtering and clipping, seeChapter 4.14, "Fil-
ter / Clipping Settings", on page 73.

4.2 Trigger Settings

This tab provides access to the settings necessary to select and configure the trigger,
like trigger source, mode, trigger delay, trigger suppression, as well as to arm or trigger
an internal trigger manually. The current signal generation status is displayed in the
header of the tab together with information on the enabled trigger mode. As in the
"Marker" and "Clock" tabs, this tab provides also an access to the settings of the rela-
ted connectors.

This section focuses on the available settings.
For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMW user manual.

► To access this dialog, select "Baseband > IEEE 802.11 WLAN > Trigger In".

This dialog comprises the settings required for configuring the trigger signal.

 

Trigger Settings
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Routing and Enabling a Trigger
The provided trigger signals are not dedicated to a particular connector but can be
mapped to one or more globally shared USER or local T/M/(C) connectors.
Use the Local and Global Connector Settings to configure the signal mapping as well
as the polarity, the trigger threshold and the input impedance of the input connectors.
To route and enable a trigger signal, perform the following general steps:
● Define the signal source and the effect of a trigger event, i.e. select the "Trigger In

> Mode" and "Trigger In > Source"
● Define the connector, USER or T/M/(C), the selected signal is provided at, i.e. con-

figure the Local and Global Connector Settings.

Trigger Settings Common to All Basebands
To enable simultaneous signal generation in all basebands, the R&S SMW couples the
trigger settings in the available basebands in any instrument's configuration involving
signal routing with signal addition (e.g. MIMO configuration, routing and summing of
basebands and/or streams).

The icon  indicates that common trigger settings are applied.

You can access and configure the common trigger source and trigger mode settings in
any of the basebands. An arm or a restart trigger event applies to all basebands, too.
You can still apply different delay to each of the triggers individually.

Trigger Mode ← Trigger Settings Common to All Basebands
Selects trigger mode, i.e. determines the effect of a trigger event on the signal genera-
tion.

For more information, refer to chapter "Basics" in the R&S SMW user manual.

● "Auto"
The signal is generated continuously.

● "Retrigger"
The signal is generated continuously. A trigger event (internal or external) causes a
restart.

● "Armed_Auto"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously.
An "Arm" stops the signal generation. A subsequent trigger event (internal with or
external) causes a restart.

● "Armed_Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal with or
external) causes a restart.

● "Single"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal or external) causes a restart.
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Remote command: 
[:SOURce<hw>]:BB:WLNN[:TRIGger]:SEQuence on page 100

Signal Duration Unit ← Trigger Settings Common to All Basebands
Defines the unit for describing the length of the signal sequence to be output in the
"Single" trigger mode.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:SLUNit on page 98

Trigger Signal Duration ← Trigger Settings Common to All Basebands
Enters the length of the signal sequence to be output in the "Single" trigger mode.

Use this parameter to deliberately output part of the signal, an exact sequence of the
signal, or a defined number of repetitions of the signal.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:SLENgth on page 98

Running/Stopped ← Trigger Settings Common to All Basebands
For enabled modulation, displays the status of signal generation for all trigger modes.
● "Running"

The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

● "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:RMODe? on page 97

Arm ← Trigger Settings Common to All Basebands
Stops the signal generation until subsequent trigger event occurs.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:ARM:EXECute on page 95

Execute Trigger ← Trigger Settings Common to All Basebands
For internal trigger source, executes trigger manually.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:EXECute on page 96

Trigger Source ← Trigger Settings Common to All Basebands
The following sources of the trigger signal are available:
● "Internal"

The trigger event is executed manually by the "Execute Trigger".
● "Internal (Baseband A/B)"

The trigger event is provided by the trigger signal from the other basebands.
If common trigger settings are applied, this trigger source is disabled.

● "External Global Trigger 1 / 2"
The trigger event is the active edge of an external trigger signal provided and con-
figured at the global USER connectors.

● "External Global Clock 1 / 2"

Trigger Settings



WLAN Configuration and SettingsR&S®SMW-K54/-K86

23User Manual 1175.6749.02 ─ 08

The trigger event is the active edge of an external global clock signal provided and
configured at the global USER connectors.

● "External Local Trigger"
The trigger event is the active edge of an external trigger signal provided and con-
figured at the local T/M/(C) connector.
With coupled trigger settings, the signal has to be provided at the T/M/C 1/2/3 con-
nectors.

● "External Local Clock"
The trigger event is the active edge of an external local clock signal provided and
configured at the local T/M/C connector.
With coupled trigger settings, the signal has to be provided at the T/M/C 1 connec-
tor.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:SOURce on page 99

Sync. Output to External Trigger ← Trigger Settings Common to All Basebands
For an external trigger signal, enables/disables the output of a signal synchronous to
the external trigger event.

"On" Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the external trigger
event but because of the instrument’s processing time the first sam-
ples are cut off and no signal is output. After elapsing of the internal
processing time, the output signal is synchronous to the trigger event.
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"Off" The signal output begins after elapsing of the processing time and
starts with sample 0, i.e. the complete signal is output.
This mode is recommended for triggering of short signal sequences
with signal duration comparable with the processing time of the
instrument.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:EXTernal:SYNChronize:OUTPut
on page 96

External Trigger Inhibit ← Trigger Settings Common to All Basebands
For external trigger signal or trigger signal from the other path, sets the duration a new
trigger event subsequent to triggering is suppressed. In "Retrigger" mode for example,
a new trigger event will not cause a restart of the signal generation until the specified
inhibit duration does not expire.

For more information, see chapter "Basics" in the R&S SMW User Manual.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger[:EXTernal]:INHibit on page 99
[:SOURce<hw>]:BB:WLNN:TRIGger:OBASeband:INHibit on page 97

Trigger Delay
Delays the trigger event of the signal from:
● the external trigger source
● the other path
● the other basebands (internal trigger), if common trigger settings are used.
Use this setting to:
● synchronize the instrument with the device under test (DUT) or other external devi-

ces
● postpone the signal generation start in the basebands compared to each other
For more information, see chapter "Basics on ..." in the R&S SMW User Manual.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger[:EXTernal]:DELay on page 99
[:SOURce<hw>]:BB:WLNN:TRIGger:OBASeband:DELay on page 96

Trigger Settings



WLAN Configuration and SettingsR&S®SMW-K54/-K86

25User Manual 1175.6749.02 ─ 08

4.3 Marker Settings

This tab provides access to the settings necessary to select and configure the marker
output signal, like the marker mode or marker delay settings.

This section focuses on the available settings.
For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMW user manual.

► To access this dialog, select "Baseband > IEEE 802.11 WLAN > Marker".

This dialog comprises the settings required for configuring the marker mode and
the marker delay.

Routing and Enabling a Marker
The provided marker signals are not dedicated to a particular connector but can be
mapped to one or more globally shared USER or local T/M/(C) connectors.
To route and enable a marker signal, perform the following general steps:
● Define the shape of the generated marker, i.e. select the "Marker > Mode"
● Define the connector, USER or T/M/(C), the selected signal is output at, i.e. config-

ure the Local and Global Connector Settings.
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Marker Mode
Selects a marker signal for the associated MARKER output.

"Restart" A marker signal is generated at the start of each signal sequence
(period = all frame blocks).
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"Frame Block" Number of Frame Blocks = 1, that is, a marker signal is generated at
the start of each frame block. Otherwise a specific frame block index
is given and the whole frame block is marked.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FBINdex on page 104

"Frame" Number of Frame Blocks = 1, that is, a marker signal is generated at
the start of each frame in the single frame block. Otherwise, the
frame block and frame index are entered and the specific frame is
masked.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FINDex on page 104

"Frame Active Part / Frame Inactive Part"
A marker signal is generated to mark every active part of each frame.
The active data transfer part (PPDU) of a frame period is marked with
high, the inactive part (idle time) with low. This marker can be used to
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decrease the carrier leakage during inactive signal parts by feeding it
into the pulse modulator.
Otherwise, the frame block and frame index are entered and the
active part of the specific frame is masked.
The parameters "Rising Edge Shift / Falling Edge Shift" open when
"Frame Active Part" or "Frame Inactive Part" is selected.
They shift the rising/falling edge of the marker the specified number
of samples. Negative values result in a shift back of the marker edge.

Figure 4-1: "Frame active Part" marker and shifting of its rising/falling edges

1 = Marker shift rising edge
2 = Marker shift falling edge

Figure 4-2: "Frame Inactive Part" marker and shifting of its rising/falling edges

1 = Marker shift rising edge
2 = Marker shift falling edge

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FESHift on page 105
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:RESHift on page 105
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"Pulse" A regular marker signal is generated. The clock frequency is defined
by entering a divider. The frequency is derived by dividing the chip
rate by the divider. The input box for the divider opens when Pulse is
selected, and the resulting pulse frequency is displayed below it.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PULSe:DIVider on page 106
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PULSe:FREQuency?
on page 106

"Pattern" A marker signal that is defined by a bit pattern is generated. The pat-
tern has a maximum length of 32 bits and is defined in an input field
that opens when "pattern" is selected.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PATTern on page 105

"ON/OFF Ratio"
A regular marker signal that is defined by an ON/OFF ratio is gener-
ated. A period lasts one ON and OFF cycle.

The ON time and OFF time are each expressed as a number of chips
and are set in an input field which opens when ON/OFF ratio is
selected.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:ONTime on page 104
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:OFFTime on page 104

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:MODE on page 103

Marker x Delay
Defines the delay between the marker signal at the marker outputs relative to the sig-
nal generation start.

"Marker x" For the corresponding marker, sets the delay as a number of sym-
bols.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay on page 101

"Current Range without Recalculation"
Displays the dynamic range within which the delay of the marker sig-
nals can be set without restarting the marker and the signal.
Move the setting mark to define the delay.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay:MAXimum?
on page 102
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay:MINimum?
on page 102
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"Fix marker delay to current range"
Restricts the marker delay setting range to the dynamic range.

Remote command: 
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut:DELay:FIXed on page 101

4.4 Clock Settings

This tab provides access to the settings necessary to select and configure the clock
signal, like the clock source and clock mode.

This section focuses on the available settings.
For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMW user manual.

► To access this dialog, select "Baseband > IEEE 802.11 WLAN > Clock".

This dialog comprises the settings required for configuring the clock signal.

Defining the Clock
The provided clock signals are not dedicated to a particular connector but can be map-
ped to one or more globally shared USER and the two local T/M/C connectors.
Use the Local and Global Connector Settings to configure the signal mapping as well
as the polarity, the trigger threshold and the input impedance of the input connectors.
To route and enable a trigger signal, perform the following general steps:
● Define the signal source, i.e. select the "Clock > Source"
● Define the connector, USER or T/M/C, the selected signal is provided at, i.e. con-

figure the Local and Global Connector Settings.

Clock Source
Selects the clock source.
● "Internal"

The instrument uses its internal clock reference.
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● "External Global Clock 1/2"
The instrument expects an external clock reference at the global USER connector,
as configured in the "Global Connector Settings" dialog.

● "External Local Clock"
The instrument expects an external clock reference at the local T/M/C connector.

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLOCk:SOURce on page 107

Clock Mode
Enters the type of externally supplied clock.

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLOCk:MODE on page 107

Clock Multiplier
Enters the multiplication factor for clock type "Multiple".

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLOCk:MULTiplier on page 107

Measured External Clock
Provided for permanent monitoring of the enabled and externally supplied clock signal.

Remote command: 
CLOCk:INPut:FREQuency?

4.5 Local and Global Connector Settings

Each of the "Trigger In", "Marker" and "Clock" dialogs as well as the "Trigger Marker
Clock" dialog provides a quick access to the related local and global connector set-
tings.

For more information, refer to the description R&S SMW User Manual, section "Local
and Global Connectors".
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4.6 Frame Block Configuration

► To access this dialog select "Baseband > IEEE 802.11 WLAN > Frame Blocks".

This tab comprises the settings to select and configure a frame block.

Standard
Selects the IEEE 802.11 WLAN standard. After you have set your standard only the for
this standard relevant "Type", "Physical Mode" and "Tx Mode" are available, see
Table 4-1.
Table 4-1: Availability "Standard", "Type", "Physical Mode", "TxMode"

Standard Type Physical Mode Tx Mode

User all all all

11a/g Data/ Beacon Legacy L-20MHz

   L-Duplicate

   L-Upper

   L-Lower

11b/g Data/ Beacon Legacy CCK

   PBCC

11p/j Data/ Beacon Legacy L-10MHz

11n Data/ Sounding/Beacon Mixed Mode/ Green
Field

HT-20MHz

   HT-40MHz

   HT-Duplicate
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   HT-Upper

   HT-Lower

11ac Data/ Sounding/ Beacon Mixed Mode VHT-20MHz

   VHT-40MHz

   VHT-80MHz

   VHT-80 + 80 MHz

   VHT-160MHz

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STANdard on page 114

Type
Selects the PPDU type.

"Data" Only Data Long Training Fields are used to probe the channel.

"Sounding" Staggered preambles are used to probe additional dimension of the
MIMO channel.
"Type > Sounding" is not available for "Physical Mode > Legacy".

"Beacon" A frame of type "Beacon" contains all the information about a net-
work, for example the beacon interval, capability information and the
IBSS parameter set. The access point (AP) of a service set periodi-
cally transmits the beacon frame to establish and maintain the net-
work.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TYPE on page 116

Physical Mode
Selects the preamble design.

For "Physical Mode > Legacy" only "Type > Data" is available.

From 80 MHz transmission bandwidth in the frame block "Type > Data" you can only
operate in "Physical Mode > Mixed Mode".

Note: "Physical Mode > Mixed Mode" transmissions can be detected by a physical
layer transceiver of 802.11a/g OFDM, MAC FCS would however fail.

"Legacy" Compatible with 802.11a/g OFDM devices. Additionally, CCK/PBCC
frames as defined in IEEE 802.11b/g are supported.
This mode applies to "Cylindrical" mapping coordinates.

"Mixed Mode" For High Throughput (HT), Very High Throughput (VHT) and
802.11a/g OFDM devices.

"Green Field" For HT networks only.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PMODe on page 114

Tx Mode
Sets the Tx mode.
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The available Tx modes are dependent on the physical mode (see table below).

Type Physical
Mode

Tx Mode Transmission Bandwidth

20 MHz 40 MHz 80 MHz 160 MHz

Data Legacy L-10MHz X X X X

L-20MHz X X X X

L-Duplicate - X X X

L-Upper - X X X

L-Lower - X X X

CCK X X X X

PBCC X X X X

Data / Sound-
ing

Mixed Mode HT-20MHz X X X X

HT-40MHz - X X X

HT-Duplicate - X X X

HT-Upper - X X X

HT-Lower - X X X

VHT-20MHz X X X X

VHT-40MHz - X X X

VHT-80MHz - - X X

VHT-80+80MHz - - X X

VHT-160MHz - - - X

Data Green Field HT-20MHz X X X X

HT-40MHz - X X X

HT-Duplicate - X X X

HT-Upper - X X X

HT-Lower - X X X

Sounding Green Field HT-20MHz X X X X

HT-40MHz - X X X

HT-Duplicate - X X X

HT-Upper - X X X

HT-Lower - X X X

Beacon Legacy L-10MHz X X X X

L-20MHz X X X X

L-Duplicate - X X X

L-Upper - X X X
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Type Physical
Mode

Tx Mode Transmission Bandwidth

20 MHz 40 MHz 80 MHz 160 MHz

L-Lower - X X X

CCK X X X X

PBCC X X X X

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TMODe on page 115

Frames
Sets the number of frames to be transmitted in the current frame block.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:FCOunt on page 112

Idle Time / ms
Sets the time interval separating two frames in this frame block.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ITIMe on page 113

Data
Selects the data source.

The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.
– Use the "New" and "Edit" functions to create internally new data list or to edit

an existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● section "Modulation Data" in the R&S SMW user manual.
● section "File and Data Management" in the R&S SMW user manual.
● section "Data List Editor" in the R&S SMW user manual

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA on page 112
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:PATTern on page 113
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:DSELection on page 112
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Boost /dB
Assigns a specific RMS power boost/attenuation to the corresponding Frame Block
Modulation.

The power level of a Frame Block Modulation is calculated as sum of the power boost
and the power level set in the header of the instrument.

Note: At least one Frame Block should have a power boost set to a 0 dB value for this
gated power mode functionality to work properly.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BOOSt on page 111

PPDU
Calls the dialog for PPDU configuration of the frame blocks.

The dialog is described in Chapter 4.8, "PPDU Configuration", on page 39.

Remote command: 
n.a.

Data Rate/Mbps
Indicates the PPDU data rate.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:RATE? on page 113

State
Enables the corresponding frame block for transmission.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STATe on page 115

Append
Adds a default frame block behind the selected frame block.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock:APPend on page 86

Insert
Adds a default frame block before the selected frame block.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:INSert on page 86

Delete
Deletes the selected frame block.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DELete on page 87

Copy
Copies the selected frame block.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:COPY on page 87

Paste
Pastes the copied frame block behind the selected frame block.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PASTe on page 87

4.7 Transmit Antenna Setup

► To access this dialog select "Baseband > WLAN Standards > IEEE 802.11...>
General > Transmit Antennas Setup".

This dialog is used to map the generated Tx chains to different destinations (Base-
band A/B, File or OFF) and makes it possible to combine different Tx antenna sig-
nals.

4.7.1 Antenna and Mapping Setting

Antennas
Selects the number of transmit antennas to be used.

Remote command: 
[:SOURce<hw>]:BB:WLNN:ANTenna:MODE on page 108

Mapping Coordinates
Selects the coordinate system of the transmission chain matrix.

"Cartesian" Sets the cartesian coordinates system (Real, Imaginary).

"Cylindrical" Sets the cylindrical coordinates system (Magnitude, Phase).
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Remote command: 
[:SOURce<hw>]:BB:WLNN:ANTenna:SYSTem on page 108

4.7.2 Transmission Chain Matrix

The transmission chain matrix can be used to adjust the channel coefficients.

During signal calculation, the R&S SMW evaluates the transmission matrix and takes
the phase ratios set into account. However, the power ratio of the antennas is not con-
sidered. To enable the R&S SMW to generate a WLAN signal of antennas with differ-
ent power level, set the power level of the corresponding path to the desired level in
the header display of the instrument.

Output
Selects the destination of the calculated IQ chains.

"OFF" No mapping takes place.

"Baseband
A/B"

The IQ chain is output to the selected baseband. Exactly one output
stream can be mapped to a baseband.

"File" The IQ chain is saved in a file.

Remote command: 
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:DESTination
on page 109
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:FSELect
on page 109

Real/Magnitude
Enters the value of the real or the magnitude coordinates.

Remote command: 
For Cartesian mapping coordinates:
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:REAL on page 110
For Cylindrical mapping coordinates:
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:MAGNitude
on page 110

Imaginary/Phase
Enters the value of the imaginary or the phase coordinates.

Remote command: 
For Cartesian mapping coordinates:
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:IMAGinary
on page 110
For Cylindrical mapping coordinates:
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:PHASe on page 110
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4.8 PPDU Configuration

► To access this dialog select "Frame Blocks > PPDU > Config...".

In this dialog the mode, the time shifts and the transmit parameters can be config-
ured. The parameters available for configuration depend on the selected "Type",
"Physical Layer" and "Tx Mode"

4.8.1 General Settings

1. To access this dialog select "Frame Blocks > PPDU > Config...".

2. Select "General".

This dialog comprises the settings for the configuration of the stream settings, the
modulation and coding scheme as well as the PSDU bit rate. The parameters
available for configuration depend on the selected "Type", "Physical Layer" and "Tx
Mode".

4.8.1.1 Stream Settings

Provided are the following settings:
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Spatial Streams
Enters the number of the spatial streams. For "Physical Mode > Legacy", only the
value 1 is valid. For "Tx Mode > HT-Duplicate", only the value 1 is valid. In all other
cases, the number of spatial streams depends on the number of antennas configured
in the "TX Antenna Setup" window.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SSTReam on page 129

Space Time Streams
Enters the number of the space time streams. This value depends on the setting in the
"Spatial Streams" field. Changing the number of the spatial streams immediately
changes the value of the "Space Time Streams" to the same value.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STSTream on page 129

Extended Spatial Streams
Enters the value of the extended spatial streams. This field is active for "Type > Sound-
ing" only to probe additional dimensions of the channel.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ESSTream on page 121

Multi User MIMO
Activates Multi User MIMO. This function applies to "Spatial Streams">1.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MUMimo:STATe on page 122

Segment
(available only for "Tx Mode > VHT-80+80 MHz")

In "Tx Mode > VHT-80+80 MHz" one of the two segments can be selected with trans-
mission bandwidth 80 or 160 MHz. Both segments can be only generated with band-
width 160 MHz.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SEGMent on page 127

Space Time Block Coding
Displays the status of the space time block coding.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STBC:STATe? on page 129

4.8.1.2 User Settings

1. To access this dialog select "Spatial Streams "> 1.
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2. Select "Multi User MIMO > ON".

This section contains the parameters for selecting and configuring signal genera-
tion of multiple users.

Provided are the following settings:

User Index
Defines the currently generated user. For "Multi User MIMO > Active" only one user
can be generated at a time. This parameter selects the generated one out of four avail-
able users.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:UINDex on page 130

Multi User MIMO Settings Table
Sets the user defined parameters for all available users.
● User Index

a maximum of four users are supported
● N_STS

number of space time streams for each user
● Group ID

group ID for each user

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MU<st0>:NSTS on page 123
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MU<st0>:GID on page 122

4.8.1.3 Modulation and Coding Scheme

Provided are the following settings:
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MCS
Selects the modulation and coding scheme for all spatial streams.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MCS on page 121

Data Rate/Mbps
Indicates the PPDU data rate.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:RATE? on page 113

Data Bits Per Symbol
Displays the number of data bits sent by an OFDM symbol on all spatial streams.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:BPSymbol? on page 119

Stream n
Selects the modulation used for the selected spatial stream.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MODulation<st> on page 122

Channel Coding
Selects the channel coding.

"Off" No channel coding is used.

"BCC" Binary convolution code

"LDPC" Low density parity check. This is an optional coding for the
IEEE 802.11ac and IEEE 802.11n standards. Available only for "Tx
Mode > HT.../VHT...".

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:TYPE on page 119

Encoders
Displays the number of encoders to be used. This value depends on the data rate. For
data rate ≤ 300 Mps, this value is 1. Otherwise, the number of encoders is 2.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:ENCoder? on page 118

Cod Rate
Selects the coding rate.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:RATE on page 118

Guard
Selects whether a long or short guard interval is used for the OFDM guard. In "Physical
Mode > Green Field /Legacy" only long guard intervals are possible. In this case, the
field is read-only.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:GUARd on page 121

4.8.1.4 PSDU Bit Rate (CCK/PBCC)

1. To access this dialog select "Frame Blocks > Physical Mode > Legacy ".

2. Select "TxMode > CCK / PBCC ".

3. Select "PPDU > Conf"...

In this dialog the "PSDU Bit Rate (OFDM)" can be set.

Provided are the following settings:

PSDU Bit Rate
(available only for "Tx Mode > CCK/PBCC")

Selects the bit rate of the PSDU.

The data rates available are 1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps and 22 Mbps. The
1 Mbps data rate is only available if the long PLCP format has been selected. The
selection of the data rate also determines the possible modulation modes.

The following table shows the correlation between data rate and modulation.

Data rate Possible modulation mode

1 Mbps Barker Sequence (DBPSK)

the information data sequence is spread with an 11-chip Barker
sequence, chip rate is 11 Mcps

2 Mbps Barker Sequence (DQPSK)

the information data sequence is spread with an 11-chip Barker
sequence, chip rate is 11 Mcps

5.5 Mbps CCK (DQPSK) or PBCC (BPSK)

11 Mbps CCK (DQPSK) or PBCC (QPSK)

22 Mbps PBCC (8PSK)

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:BRATe on page 125

PSDU Modulation
(available only for "Tx Mode > CCK/PBCC")

Indicates the modulation type.

The modulation type is determined by the selected PSDU Bit Rate.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:MODulation? on page 126

Barker Spreading
(available only for "Tx Mode > CCK/PBCC")

Activates/deactivates barker spreading (bit rates 1 Mbps or 2 Mbps only).

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:BSPReading:STATe on page 125

4.8.2 Data Settings

1. To access this dialog select "Frame Blocks > PPDU > Config...".

2. Select "Data".

This dialog comprises the settings for the configuration of the data and the header.
The parameters available for configuration depend on the selected "Type", "Physi-
cal Layer" and "Tx Mode"

4.8.2.1 Data Settings

Data Length
Sets the size of the data field in bytes.

For Data Length = 0, no data field will be generated for the case of a sounding frame.
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The maximum data length depends on the physical mode:
● In "Physical Mode > Legacy", the maximum value is 4061 Bytes.
● In "Physical Mode > Mixed Mode" and "Physical Mode > Green Field", the maxi-

mum value is 1048575 Bytes.
The data length is related to the number of data symbols. Whenever the data length
changes, the number of data symbols is updated and vice versa.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:LENGth on page 119

Scrambler
Selects the different options for the scrambler.

"OFF" The scrambler is deactivated.

"On (Random
Init)"

(not available for "Tx Mode > CCK/PBCC"
The scrambler is activated.
The initialization value of the scrambler is selected at random. Each
frame has a different random initialization value. This value is also dif-
ferent in case of successive recalculations with the same setting
parameters so that different signals are generated for each calcula-
tion.

"On (User Init)" (not available for "Tx Mode > CCK/PBCC")
The scrambler is activated.
The initialization value of the scrambler is set to a fixed value that is
entered in the "Scrambler Init (hex)". This value is then identical in
each generated frame.

"ON" (available only for "Tx Mode > CCK/PBCC")
The scrambler is activated.

"Preamble
Only"

(available only for "Tx Mode > CCK/PBCC")
The scrambler is activated.
Only the preamble is scrambled.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:MODE on page 126

Ch. Bandwidth in Non HT
(available only for "Tx Mode > VHT")

This parameter is used to modify the first 7 bits of the scrambling sequence to indicate
the duplicated bandwidth of the PPDU.

"NON_HT20 |
40 | 80 | 160"

Indicates 20 MHz, 40MHz, 80MHz or 160 (80+80) MHz channel
bandwidth of the transmitted packet.

"Not present" Channel bandwidth in Non HT is not present.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CBINonht on page 118

Interleaver Active
Activates/deactivates the interleaver of the data field.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ILEaver:STATe on page 121

Time Domain Windowing Active
Activates/deactivates the time domain windowing.

Time domain windowing is a method to influence the spectral characteristics of the sig-
nal, which is not stipulated by the standard. However, it does not replace oversampling
and subsequent signal filtering.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TDWindowing:STATe on page 130

Number Of Data Symbols
Sets the number of data symbols per frame block.

If the number of OFDM data symbols is changed, the generator calculates the data
field length as a function of the set PPDU bit rate and displays it at "Data Length".

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:SYMBols on page 120

Scrambler Init (hex)
Enters the initialization value for "Scrambler >User". This value is then identical in each
generated frame.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:PATTern on page 127

Dyn. Bandwidth in Non HT
(available only for "Tx Mode > VHT")

If present, this parameter is used to modify the first 7 bits of the scrambling sequence
to indicate if the transmitter is capable of "Static" or "Dynamic" bandwidth operation.

"Not present" Dynamic bandwidth in Non HT is not present.

"Static" The transmitter is capable of static bandwidth operation.

"Dynamic" The transmitter is capable of dynamic bandwidth operation.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DBINonht on page 120

Service Field (hex)
Enters the value of the service field. The standard specifies a default value of 0. Other
values can be entered in hexadecimal form for test purposes or future extensions.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SERVice:PATTern on page 128

Transition Time
Sets the transition time when "Time Domain Windowing > Active".

The transition time defines the overlap range of two OFDM symbols. At a setting of 100
ns and if BW = 20 MHz, one sample overlaps.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TTIMe on page 130

Service Field Clock Bit
(available only for "Tx Mode > CCK/PBCC")

Sets the Locked Clock Bit in Service Field of the PLCP Header.

Via this flag (bit), the transmitter indicates whether transmission frequency and symbol
rate have been derived from the same oscillator. If this is the case (locked), the bit is
set to 1, otherwise (not locked) to 0.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PLCP:LCBit:STATe on page 124

PLCP P+H Format
(available only for "Tx Mode > CCK/PBCC")

Selects the packet type (PPDU format) with long or short PLCP (physical layer conver-
gence protocol).

Depending on the selected format, the structure, modulation and data rate of the PLCP
the preamble and the header are modified.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PLCP:FORMat on page 124

4.8.2.2 Header Settings

Preamble/Header Active
Activates/deactivates the preamble and signal fields of the frames in the current frame
block.

For "Type > Sounding", the preamble and signal field are always activated and cannot
be deactivated.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PREamble:STATe on page 125

Smoothing
(available for all except "Tx Mode > VHT")

Indicates to the receiver whether frequency-domain smoothing is recommended as
part of channel estimation.

"On" Indicates that channel estimate smoothing is recommended.

"Off" Indicates that only per-carrier independent channel (unsmoothed)
estimate is recommended.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMOothing on page 128

Partial AID (hex)
(available only for "Tx Mode > VHT")

Provides an abbreviated indication of the intended recipient(s) of the frame.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PAID:PATTern on page 123

No TXOP PS
(available only for "Tx Mode > VHT")

Indicates whether the VHT access point (AP) allows VHT non-AP stations (STAs) in
transmit opportunity (TXOP) power save mode to enter during TXOP.

"On" Indicates that the VHT AP allows VHT non-AP STAs to enter doze
mode during a TXOP.

"Off" Indicates that the VHT AP does not allow VHT non-AP STAs to enter
doze mode during a TXOP.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:NTPS on page 123

4.9 A-MPDU Settings

This chapter describes the aggregate mac protocol data unit (A-MPDU) settings.

1. To access this dialog select "IEEE 802.11... > Frame Blocks".

2. Select "Type > Data".

3. Select "Data > A-MPDU".

4. Select "DList/Pattern > Config".

5. Select "A-MPDU".

This dialog comprises the A-MPDU settings.

Number of MPDUs
Determines the number of MPDUs in the frame.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU:COUNt on page 131

A-MPDU Length
Indicates the overall A-MPDUs length, resulting from the "Data Length / bytes" settings
of all MPDUs.

Remote command: 
n.a.

EOF
Selects the EOF value.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU:EOF on page 132

Data Length / bytes
Determines the size of the data field in bytes.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:LENGth on page 131

Data
Selects the data source.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:SOURce on page 132

DList / Pattern
Depending on the selected data source, selects a data list or allows entering a user
defined bit pattern.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:DSELection
on page 131
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:PATTern on page 132

4.10 Data Settings

1. To access this dialog select "Frame Blocks > PPDU > Config...".
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2. Select "Data".

This dialog comprises the settings for the configuration of the data and the header.
The parameters available for configuration depend on the selected "Type", "Physi-
cal Layer" and "Tx Mode"

4.10.1 Data Settings

Data Length
Sets the size of the data field in bytes.

For Data Length = 0, no data field will be generated for the case of a sounding frame.

The maximum data length depends on the physical mode:
● In "Physical Mode > Legacy", the maximum value is 4061 Bytes.
● In "Physical Mode > Mixed Mode" and "Physical Mode > Green Field", the maxi-

mum value is 1048575 Bytes.
The data length is related to the number of data symbols. Whenever the data length
changes, the number of data symbols is updated and vice versa.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:LENGth on page 119

Scrambler
Selects the different options for the scrambler.

"OFF" The scrambler is deactivated.
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"On (Random
Init)"

(not available for "Tx Mode > CCK/PBCC"
The scrambler is activated.
The initialization value of the scrambler is selected at random. Each
frame has a different random initialization value. This value is also dif-
ferent in case of successive recalculations with the same setting
parameters so that different signals are generated for each calcula-
tion.

"On (User Init)" (not available for "Tx Mode > CCK/PBCC")
The scrambler is activated.
The initialization value of the scrambler is set to a fixed value that is
entered in the "Scrambler Init (hex)". This value is then identical in
each generated frame.

"ON" (available only for "Tx Mode > CCK/PBCC")
The scrambler is activated.

"Preamble
Only"

(available only for "Tx Mode > CCK/PBCC")
The scrambler is activated.
Only the preamble is scrambled.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:MODE on page 126

Ch. Bandwidth in Non HT
(available only for "Tx Mode > VHT")

This parameter is used to modify the first 7 bits of the scrambling sequence to indicate
the duplicated bandwidth of the PPDU.

"NON_HT20 |
40 | 80 | 160"

Indicates 20 MHz, 40MHz, 80MHz or 160 (80+80) MHz channel
bandwidth of the transmitted packet.

"Not present" Channel bandwidth in Non HT is not present.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CBINonht on page 118

Interleaver Active
Activates/deactivates the interleaver of the data field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ILEaver:STATe on page 121

Time Domain Windowing Active
Activates/deactivates the time domain windowing.

Time domain windowing is a method to influence the spectral characteristics of the sig-
nal, which is not stipulated by the standard. However, it does not replace oversampling
and subsequent signal filtering.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TDWindowing:STATe on page 130

Number Of Data Symbols
Sets the number of data symbols per frame block.

Data Settings



WLAN Configuration and SettingsR&S®SMW-K54/-K86

52User Manual 1175.6749.02 ─ 08

If the number of OFDM data symbols is changed, the generator calculates the data
field length as a function of the set PPDU bit rate and displays it at "Data Length".

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:SYMBols on page 120

Scrambler Init (hex)
Enters the initialization value for "Scrambler >User". This value is then identical in each
generated frame.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:PATTern on page 127

Dyn. Bandwidth in Non HT
(available only for "Tx Mode > VHT")

If present, this parameter is used to modify the first 7 bits of the scrambling sequence
to indicate if the transmitter is capable of "Static" or "Dynamic" bandwidth operation.

"Not present" Dynamic bandwidth in Non HT is not present.

"Static" The transmitter is capable of static bandwidth operation.

"Dynamic" The transmitter is capable of dynamic bandwidth operation.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DBINonht on page 120

Service Field (hex)
Enters the value of the service field. The standard specifies a default value of 0. Other
values can be entered in hexadecimal form for test purposes or future extensions.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SERVice:PATTern on page 128

Transition Time
Sets the transition time when "Time Domain Windowing > Active".

The transition time defines the overlap range of two OFDM symbols. At a setting of 100
ns and if BW = 20 MHz, one sample overlaps.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TTIMe on page 130

Service Field Clock Bit
(available only for "Tx Mode > CCK/PBCC")

Sets the Locked Clock Bit in Service Field of the PLCP Header.

Via this flag (bit), the transmitter indicates whether transmission frequency and symbol
rate have been derived from the same oscillator. If this is the case (locked), the bit is
set to 1, otherwise (not locked) to 0.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PLCP:LCBit:STATe on page 124

PLCP P+H Format
(available only for "Tx Mode > CCK/PBCC")
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Selects the packet type (PPDU format) with long or short PLCP (physical layer conver-
gence protocol).

Depending on the selected format, the structure, modulation and data rate of the PLCP
the preamble and the header are modified.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PLCP:FORMat on page 124

4.10.2 Header Settings

Preamble/Header Active
Activates/deactivates the preamble and signal fields of the frames in the current frame
block.

For "Type > Sounding", the preamble and signal field are always activated and cannot
be deactivated.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PREamble:STATe on page 125

Smoothing
(available for all except "Tx Mode > VHT")

Indicates to the receiver whether frequency-domain smoothing is recommended as
part of channel estimation.

"On" Indicates that channel estimate smoothing is recommended.

"Off" Indicates that only per-carrier independent channel (unsmoothed)
estimate is recommended.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMOothing on page 128

Partial AID (hex)
(available only for "Tx Mode > VHT")

Provides an abbreviated indication of the intended recipient(s) of the frame.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PAID:PATTern on page 123

No TXOP PS
(available only for "Tx Mode > VHT")

Indicates whether the VHT access point (AP) allows VHT non-AP stations (STAs) in
transmit opportunity (TXOP) power save mode to enter during TXOP.

"On" Indicates that the VHT AP allows VHT non-AP STAs to enter doze
mode during a TXOP.

"Off" Indicates that the VHT AP does not allow VHT non-AP STAs to enter
doze mode during a TXOP.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:NTPS on page 123

4.11 MAC Header and FCS Configuration for Frame Block

In the real IEEE 802.11 system, a MAC (medium access control) header is transmitted
in the PPDU prior to the actual data section. This header comprises the control infor-
mation of the MAC layer. It is also possible to protect the PPDU by a frame checksum.
These two functions can be controlled in the dialog.

1. To access this dialog select "IEEE 802.11... > Frame Blocks".

2. Select "PPDU > Config...".

3. Select "MAC Header & FCS".

This dialog comprises the "MAC Header" and "MAC Frame Control Field" settings.

4.11.1 MAC Header and FCS

MAC Header
Activates/deactivates the generation of the MAC Header for the PPDU. If the MAC
header is activated, all MAC header fields are enabled for operation.

The individual fields of the MAC header are described in the following.

All values of the MAC fields (except addresses) are entered in hexadecimal form with
least significant bit (LSB) in right notation. In the data stream, the values are output
standard-conformal with the LSB coming first.

Note: IEEE 802.11ac requires an A-MPDU frame aggregation. Therefore, when gener-
ating a IEEE 802.11ac signal you have to set "IEEE 802.11... > Frame Blocks> Data >
A-MPDU".
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:STATe on page 138

FCS (checksum)
Activates/deactivates the calculation of the FCS (frame check sequence). The stan-
dard defines a 32-bit (4-byte) checksum to protect the MAC header and the user data
(frame body).

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCS:STATe on page 136

4.11.2 802.11 MAC Frame Field

The MAC frame control field is used to define the protocol version, the frame type, sub
type, and its function, etc.

Frame Control
Enters the value of the frame control field.

The MAC frame control field has a length of 2 bytes (16 bits) and is used to define the
protocol version, the frame type, sub type, and its function, etc. As an alternative, the
individual bits can be set in the lower part of the graph.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol on page 134
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:PVERsion on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:TYPE on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:SUBType on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:TDS on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:FDS on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:MFRagments
on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:RETRy on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:PMANagement
on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:MDATa on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:WEP on page 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:ORDer on page 135

Duration Id
Enters the value of the duration ID field.

Depending on the frame type, the 2-byte field Duration/ID is used to transmit the asso-
ciation identity of the station transmitting the frame or it indicates the duration assigned
to the frame type.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:DID on page 134

MAC Address
Enters the value of the address fields 1 ... 4.
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The MAC header may contain up to four address fields, but not all of them must be
available. Each of the 4 address fields can be activated or deactivated. The fields are
used for transmitting the basic service set identifier, the destination address, the
source address, the receiver address and the transmitter address. Each address is 6
bytes (48 bit) long. The addresses can be entered in hexadecimal form in the entry
field of each address field. The LSB is in left notation.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:ADDRess<st>:STATe on page 134

SA (hex)
(available only for "Physical Mode > Beacon")

Enters the value of the source adress (SA) field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SA on page 135

BSSID (hex)
(available only for "Physical Mode > Beacon")

Enters the value of the basic service set identification (BSSID) field.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:BSSid on page 134

Sequence Control
Activates/deactivates the sequence control field.

The sequence control field has a length of 2 bytes and is divided in two parts, the frag-
ment number (4 bits) and the sequence number (12 bits) field. A long user data stream
to be transmitted is first split up into MSDUs (MAC service data units) which can either
be transmitted as PSDU frames or further divided into fragments. The sequence num-
ber and the fragment number are then used to number the individual subpackets of the
user data stream to be transmitted. Thus, all PSDUs are assigned a consecutive num-
ber. This allows the receiver to arrange the data packets in the correct order, to deter-
mine whether an incorrectly transmitted packet was retransmitted and to find out
whether packets are missing.

If the receiver can detect a packet without an error and does not request a retransmis-
sion, the sequence number is incremented by 1 for each packet (the field is reset to 0
at the latest after a count of 4095). The fragment number field is incremented by 1
when another fragment of the current MPDU is transmitted. The start count for the
transmission (normally 0) and the number of packets required to increment the corre-
sponding counter can be defined for both numbers. This is done with the parameters
"Start Number" and "Incremented every ... packet(s)".
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Example: 
An error-free transmission of 50 packets (no packet retransmission) is to be simulated.
The sequence number should be incremented by 1 for each packet. Since no packet is
fragmented, the fragment counter can always remain at 0. In this case the following
values have to be set:

If it is to be simulated that some packets are received incorrectly or if the response of
the receiver should be tested when the same packet arrives several times, the number
of packets required to increment the sequence number can be set to 2, for example.
Each packet will then automatically be sent twice (with identical data).

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:STATe on page 138
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:STARt
on page 137
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:STARt
on page 137
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:INCRement
on page 136
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:INCRement
on page 137

Start Number
Sets the start number of the fragment bits or the sequence bits of the sequence con-
trol.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:STARt
on page 137
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:STARt
on page 137

Increment Every
Defines the number of packets required to increment the counter of the fragment bits
or the sequence bits of the sequence control.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:INCRement
on page 136
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:INCRement
on page 137
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HT Config
Calls the menu for configuring the MAC HT (High Throughput).

Note: Only the"Physical Modes > Mixed Mode " or "Physical Modes > Green Field "
(QoS Data frames) provide the HT or VHT transmission technology. For "Physical
Modes > Legacy " this configuration field is not indicated.
The dialog is described in Chapter 4.12, "MAC Header HT and VHT Configuration",
on page 63.

Remote command: 
n.a.

Frame Body
Indicates the length of the user data (frame body).

Remote command: 
n.a.

FCS
Indicates the length of the check sum.

Remote command: 
n.a.

4.11.3 Beacon Settings

A beacon frame is a managment frame that contains all the information about a net-
work. The beacon settings are used to define the timestamp, the beacon interval, the
SSID, the supported rate etc.. They also comprise the capability information and the
ERP parameters.

1. To access this dialog select IEEE 802.11... > "Frame Blocks".

2. Select "Type > Beacon".

3. Select "PPDU > Config...".
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4. Select "MAC Header & FCS".

4.11.3.1 General Beacon Functions

Timestamp (hex)
Updates the local clock of a station (the timing synchronization function (TSF) of a
frames' source) after receiving a beacon frame.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:TSTamp
on page 150

Beacon Interval
Defines the time interval between two beacon transmissions in ms.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:BINTerval
on page 148

SSID
Specifies the desired service set identifier (SSID) or the wildcard SSID. The maximal
allowed length is 32 characters.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:SSID on page 149

SupportedRate
Contains the set of data rates that are supported by the AP, including indication which
rates are part of the BSSBasicRateSet.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:SRATe on page 149

DSSS(Current Channel)
Indicates the current channel of this direct sequence spread spectrum (DSSS) net-
work.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:DCCHannel?
on page 149

IBSS(ATIM Window) (hex)
Contains the set of parameters necessary to support an independent basic service set
(IBSS). The Information field contains the announcement traffic indication message
(ATIM) Window parameter.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:IAWindow
on page 149

4.11.3.2 Capability Information Parameters

The capability parameters indicate if requested optional capabilities and services are
allowed, supported or in use.

For example if "DSSS-OFDM" is enabled the associated stations in the network will be
informed that use of direct sequence spread spectrum - OFDM modulation (DSSS-
OFDM) is allowed.
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Capability Information Parameters
Table 4-2: Functions of capability information parameters

Function
name

If enabled this function indicates that: SCPI command

"Immediate
Block Ack"

Immediate block Ack is allowed (suitable for high-
bandwidth, low latency traffic).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:IBACk
on page 152

"Delayed
Block Ack"

Delayed block Ack is allowed (delayed block Ack is
suitable for applications that tolerate moderate
latency).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:DBACk
on page 152

"DSSS-
OFDM"

Direct Sequence Spread Spectrum - OFDM is
allowed (encodes packet data using the DSSS head-
ers and OFDM encoding of the payload).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:DOFDm
on page 153

"Radio Mea-
surement"

Radio measurement is supported (for example
requests, performs and reports radio measurements
in supported channels and provides information
about neighbor APs).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:RMEasurement
on page 154

"APSD" Automatic power save delivery (APSD) is supported
(energy saving function).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:APSD on page 150

"Short Slot
Time"

Short slot time is supported (reduces the slot time
resulting in higher throughput (used at
IEEE802.11g). The AP only uses short slot time
when all clients support short slot time).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:SSTime
on page 155

"QoS" Quality of service (QoS) is supported (takes care that
important applications always get enough band-
width).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:QOS on page 153

"Spectrum
Mgmt"

Spectrum management is enabled (the process of
regulating the use of radio frequencies).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:SMGMt
on page 154

"Channel Agil-
ity"

Channel agility is enabled (overcomes some inherent
difficulty with a tone jammer).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:CAGility
on page 151

"PBCC" Packet binary convolutional coding (PBCC) is
allowed (a modulationmode for IEEE 802.11g).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:PBCC on page 153
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Function
name

If enabled this function indicates that: SCPI command

"Short Pream-
ble"

Short preamble is allowed (uses 56 instead of 128
bits for the "sync" field. Created to improve WLAN
efficiency).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:SPReamble
on page 154

"Privacy" Privacy mode is enabled (thus encryption is required
for all data frames).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:PRIVacy
on page 153

"CF-Poll
Request"

Contention-free poll is requested (indicates how the
AP handles poll requests).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:CPRequest
on page 151

"CF Pollable" The node is capable of using the point coordination
function (PCF), as opposed to the distributed coordi-
nation function (DCF). PCF is a method of coordinat-
ing wireless transmissions in which one station noti-
fies other stations when they may broadcast.

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:CPOLlable
on page 151

"IBSS" The network is an independent basic service set
(IBSS) type network. This is an operation mode of a
WLAN. An IBSS doesn't need an AP. The wireless
clients directly connect with each other. This mode is
also named ad-hoc mode.

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:IBSS on page 152

"ESS" The network is an extended service set (ESS) type
network (this is a set of connected BSSs. APs in an
ESS are connected by a distribution system. Each
ESS has an ID called the SSID which is a 32-byte
(maximum) character string).

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:
CAPability:ESS on page 151

4.11.3.3 ERP Parameters

The extended rate PHY (ERP) parameters indicate special features/modes.
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ERP Parameters

Function-
name

If enabled this function indicates that: SCPI command

"Barker Pre-
amble Mode"

Associated stations have to use the long preamble (in
IEEE802.11g networks) . If all stations are capable of
short preambles, Barker Preamble Mode should be
disabled and all stations will use short preambles for
efficiency.

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:ERP:
BPMode on page 155

"Use Protec-
tion"

A station not IEEE802.11g-capable (usually stations
equipped with IEEE802.11b or IEEE802.11) is associ-
ated to the network and thus all stations have to
enable use protection.

"Use Protection" may be activated when "NonERP
Present" is activated.

[:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:ERP:
UPRotection on page 156

"NonERP
Present"

A Non ERP station is present in the network. [:SOURce<hw>]:BB:WLNN:
FBLock<ch>:
BFConfiguration:ERP:
NEPResent on page 156

4.11.3.4 HT Capability Information

State
Activates/ deactivates the HT capability information element.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:HTCapability:
STATe on page 155

Green Field
If enabled this function indicates that the reception of PPDUs with HT Greenfield for-
mat is supported.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:HTCapability:
GFIeld on page 155

4.12 MAC Header HT and VHT Configuration

1. To access this dialog select "Frame Blocks > PPDU > Config...".
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2. Select "MAC Header & FCS > HT Config" or "MAC Header & FCS > VHT Config"

In this dialog the mode, the time shifts and the transmit parameters can be config-
ured.

The HT/VHT Control Field may be included in any frame except a non-QoS Data
frame. The presence of the HT/VHTcontrol field in frames carried in a HT/VHT PPDU
is indicated by setting the order bit in the MAC header. The HT/VHT Control Field
appears last in the MAC Header, excluding any security fields.

4.12.1 Common Settings

Provided are the following settings for enabling the MAC HT/VHT Control Field:

QoS Control
Control field (2 Bytes) with an embedded checkbox for activating the control mecha-
nism of Quality of Service (QoS) Data Frames.

The QoS solicits an acknowledgement policy from the receiver, according to specific
feedback rules. QoS control ensures a high level of transmission performance like high
bit rate, low latency or low bit error probability.

Information on contents of the QoS Control Data frame is for example duration request
field, TXOP limit, and AP Buffer State or queue size.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:QSControl:STATe on page 136
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:QSControl on page 136
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HT/VHT Control
Enables HT/VHT control and sets the HT/VHT control field as hex value.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl on page 138
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl on page 144
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:STATe on page 143

4.12.2 MAC HT Configuration

The following functions describe the control field of the MAC HT configuration:

RDG/More PPDU
The RDG/More signal field (LSB, 1 bit) issues the reverse direction grant. When trans-
mitted by an initiator or a responder, this field is interpreted differently.

Transmitted by Initiator
0 = No reverse grant.

1 = A reverse grant is present, as defined by the Duration/ID field.

Transmitted by Responder
0 = The PPDU carrying the MPDU is the last transmission by the responder.

1 = The PPDU carrying the frame is followed by another PPDU.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:RDGMore on page 142

AC Constraint
Indicates the access point of the responder (1 bit).

0 = The response may contain data from any TID (Traffic Identifier)

1 = The response may contain data only from the same AC as the last data received
from the initiator.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:ACConstraint
on page 139

Reserved
This signal field (5 bit) is currently defined, but not used. It is set to zero by the trans-
mitter and ignored by the receiver.
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:REServed
on page 142

NDP Announcement
The NDP Announcement (1 bit) indicates that a Null Data Packet (NDP) will be trans-
mitted after the frame.

0 = no NDP will follow

1 = NDP will follow

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:NDP on page 142
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:ZLF on page 143

CSI Steering
Sets the position of the CSI feedback (2 bit)

00 = CSI

01 = uncompressed Steering Matrix

10 = compressed Steering Matrix

11 = Reserved

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CSISteering
on page 140

Reserved
This signal field (2 bit) is currently defined, but not used.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:SREServed
on page 142
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:FREQuest
on page 140

Calibration Sequence
Identifies the calibration sequence (2 bit). The field is included in each frame within the
calibration procedure. Its value remains unchanged during one calibration procedure
and is incremented each time a new calibration procedure starts.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CALibration:
SEQuence on page 139

Calibration Position
Sets the position in the Calibration Sounding Exchange sequence (2 bit):

00 = Not a calibration frame (Default setting)

01 = Calibration Start

10 = Sounding Response

11 = Sounding Complete
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CALibration:
POSition on page 139

Link Adaption Control
Sets the parameters of the link adaption control field. The following subfields enable
configuring the response signal of the link adaption.

B0 (1bit) MA - MA payload

When the MA (Management Action) field is set to 1, the payload of the QoS Null Data
MPDU (Medium Access Controller Protocol Data Unit) is interpreted as a payload of
the management action frame.

B1 (1bit) TRQ - Sounding Request

1 = Request to the responder to transmit a sounding PPDU (Physical layer Protocol
Data Unit).

B2 (1bit) MRQ - MCS Request

1 = Request for feedback of MCS (Modulation Coding Scheme).

B3-B5 (3bit) MRS - MRQ Sequence Identifier

Set by sender to any value in the range '000'-'110' to identify MRQ. = Invalid if MRQ =
0

B6-B8 (3bit) MFS - MFB Sequence Identifier

Set to the received value of MRS. Set to '111' for unsolicited MFB.

B9-B15 (7bit) MFB - MCS Feedback

Link adaptation feedback containing the recommended MCS. When a responder is
unable to provide MCS feedback or the feedback is not available, the MFB is set to 'all-
ones' (default value) and also MFS is set to '1'.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:LAControl
on page 141

HT/VHT
The subfield indicates the used format (HT or VHT).

0 = indicates use of the HT format.

1 = indicates use of the VHT format.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:HVINdicator?
on page 141

4.12.3 MAC VHT Configuration 
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The following functions describe the control field of the MAC VHT configuration:

RDG/More PPDU
The RDG/More signal field (LSB, 1 bit) issues the reverse direction grant. When trans-
mitted by an initiator or a responder, this field is interpreted differently.

Transmitted by Initiator
0 = No reverse grant.

1 = A reverse grant is present, as defined by the Duration/ID field.

Transmitted by Responder
0 = The PPDU carrying the MPDU is the last transmission by the responder.

1 = The PPDU carrying the frame is followed by another PPDU.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:RDGMore
on page 147

AC Constraint
Indicates the access point of the responder (1 bit).

0 = The response may contain data from any TID (Traffic Identifier)

1 = The response may contain data only from the same AC as the last data received
from the initiator.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:ACConstraint
on page 144

Unsolicited MFB
0 = if the MFB is a response to an MRQ.

1 = if the MFB is not a response to an MRQ.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:UMFB on page 147

FB Tx Type
0 = If the Unsolicited MFB subfield is set to 1 and FB Tx Type subfield is set to 0, the
unsolicited MFB refers to either an unbeamformed VHT PPDU or transmit diversity
using an STBC VHT PPDU.

1 = If the Unsolicited MFB subfield is set to 1 and the FB Tx Type subfield is set to 1,
the unsolicited MFB refers to a beamformed SU-MIMO VHT PPDU.

Otherwise this subfield is reserved.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:FTTYpe on page 145

Coding Type
If the Unsolicited MFB subfield is set to 1, the Coding Type subfield contains the Cod-
ing information (set to 0 for BCC and set to 1 for LDPC) to which the unsolicited MFB
refers.

0 = for BCC
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1 = for LDPC

Otherwise this subfield is reserved.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:CTYPe on page 144

GID-H
If the Unsolicited MFB subfield is set to 1, the GID-H subfield contains the highest 3
bits of Group ID of the PPDU to which the unsolicited MFB refers.

Otherwise this subfield is reserved.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:GIDH on page 145

MFB
MFB subfield is interpreted as defined in Table 4-3. This subfield contains the recom-
mended MFB. The value of MCS=15 and VHT N_STS=7 indicates that no feedback is
present.
Table 4-3: MFB subfield in the VHT format HT control field

Subfield Meaning Definition

VHT
N_STS

Recommended VHT
NSTS

Indicates the recommended VHT NSTS (Link adaption using the
VHT format of the HT Control field).

MCS Recommended MCS
feedback

Indicates the recommended VHT MCS (Link adaption using the
VHT format of the HT Control field).

BW Bandwidth of the recom-
mended MCS

MFB = 1

If the unsolicited MFB subfield is set to 1, the BW subfield con-
tains the bandwidth of which the recommended MCS is intended
for (Link adaption using the VHT format of the HT Control field).
The BW subfield is set as follows:
● 0 for 20 MHz
● 1 for 40 MHz
● 2 for 80 MHz
● 3 for 160 MHz and 80+80 MHz

MFB = 1

If the Unsolicited MFB subfield is set to 0, the BW subfield is
reserved and set to 0.

SNR Average SNR Indicates the average SNR, which is an SNR averaged over data
subcarriers and spatial streams (Link adaption using the VHT for-
mat of the HT Control field).

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MFB on page 146

MFSI/GID-L
MFB = 0
If the Unsolicited MFB subfield is set to 0, the MFSI/GID-L subfield contains the
received value of MSI contained in the frame to which the MFB information refers.

MFB = 1
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The MFSI/GID-L subfield contains the lowest 3 bits of Group ID of the PPDU to which
the unsolicited MFB refers.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MGL on page 146

MSI
MRQ = 0
When the MRQ subfield is set to 0, the MSI subfield is reserved.

MRQ = 1
When the MRQ subfield is set to 1, the MSI subfield contains a sequence number in
the range 0 to 6 that identifies the specific request.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MSI on page 147

MRQ
0 = to request MCS feedback (solicited MFB).

1 = otherwise.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MRQ on page 146

Rsv
This signal field (1 bit) is currently defined, but not used. It is set to zero by the trans-
mitter and ignored by the receiver.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:VREServed
on page 148

HT/VHT
The subfield indicates the used format (HT or VHT).

0 = indicates use of the HT format.

1 = indicates use of the VHT format.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:HVINdicator?
on page 145

4.13 Spatial Mapping

1. To access this dialog select "Frame Blocks > PPDU > Config...".
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2. Select "Spatial Mapping"

In this dialog the mode, the time shifts and the transmit parameters can be config-
ured.

The Wireless LAN standard IEEE 802.11 builds upon previous 802.11 standards by
adding MIMO (Multiple-input multiple-output). MIMO uses multiple transmitter and
receiver antennas for increased data throughput via spatial multiplexing and increased
range by exploiting the spatial diversity. Mode, time shifts and transmit parameters are
defined in the "Spatial Mapping for Frame Block" dialog.

When loaded, the spatial mapping dialog shows the frame block number for which this
spatial mapping dialog is loaded. The transmit matrix corresponding to index k will
have NTX rows (representing the number of transmit antennas) and NSTS columns (rep-
resenting the space time streams). The text label shows the spatial mapping mode
selected in the dialog which is updated whenever the mode changes. In case of physi-
cal layer mode SOUNDING, a second sub-matrix horizontally sided to the transmit
matrix with NTX rows and NESS columns (representing the number of extended spatial
streams) will be used as a transmit matrix for the Extended Long Training Fields
(ELTF). The values displayed for the transmit matrices are additionally normalized
(internally) so that the expectation of IQ sum-power of all antennas is 0 dBr. Addition-
ally for OFF, Direct, and Spatial Expansion, the expected IQ power is the same for all
antennas and hence these modes can be intermixed (frame blocks for each) without
caring about any power regulation issue. Relative RMS levels are displayed in the dia-
log for each antenna.

Mode
Selects the spatial mapping mode for the selected frame block. Except of the beam-
forming mode, the matrix element values are loaded using Info Class Methods.
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"Off" (available only for "Physical Mode > Legacy" frame)
The spatial mapping mode is switched off automatically.

"Direct" (available only for "Physical Mode > Mixed Mode" or "Physical Mode
> Green Field" when NTX = NSTS)
Sets the spatial mapping to "Direct" mode.
The transmit matrix is a CSD matrix, that is, a diagonal matrix of unit
magnitude and complex values that represent cyclic shifts in the time
domain.

"Indirect" (available only for "Physical Mode > Mixed Mode" or "Physical Mode
> Green Field" )
In indirect mode, the transmit matrix is the product of a CSD matrix
and the Hadamard unitary matrix.

"Expansion" (available only for "Physical Mode > Mixed Mode" or "Physical Mode
> Green Field" )
In expansion mode, the transmit matrix is the product of a CSD matrix
and a square matrix formed of othogonal columns, as defined in the
IEEE 802.11 specification.

"Beamforming" (this feature will be supported in further release)
Sets the spatial mapping to "Beamforming" mode.
The transmit matrix is the product of a CSD matrix and the Hadamard
unitary matrix.
The "File" button is displayed to open a Browse popup. A file with
source format *.bmf can be selected for the beamforming. The file
must include 128 4*4 IQ elements (corresponding to the sub-carri-
ers).

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:MODE on page 156
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:BSELection on page 157

Index k
Sets the index of the sub-carrier. A matrix is mapped to each sub-carrier.

With the exception of k = 0, the index can be set in the following ranges:
● 20 MHz channel, e.g. HT-20 MHz: -32 ... 31
● 40 MHz channel, e.g. VHT-40 MHz: -64 ... 63
● 80 MHz channel, e.g. VHT-80 MHz: -128 ... 127
● 160 MHz channel, e.g. VHT-160 MHz: -256 ... 255

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:INDex on page 158

Time Shift
Sets the spatial mapping time shift. This value is relevant for spatial mapping mode
Direct and Spatial Expansion only.

Spatial Mapping
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Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:TSHift<st> on page 158

I (Transmit Matrix)
Displays the time shift value of element I of the selected row and column of the spatial
transmit matrix.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:ROW<st>:COL<dir>:I?
on page 158

Q (Transmit Matrix)
Displays the time shift value of element Q of the selected row and column of the spatial
transmit matrix.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:ROW<st>:COL<dir>:Q?
on page 159

4.14 Filter / Clipping Settings

To access this dialog, select "General > Filter/Clipping Settings".

► To access this dialog, select "General > Filter/Clipping Settings".

The dialog comprises the settings, necessary to configure the baseband filterand to
enable clipping.

4.14.1 Filter Settings

Filter settings are available only for Transmission Bandwidth set to 20 MHz.
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► To access this dialog, select "Filter".

The dialog comprises the settings, necessary to configure the baseband filter.

Provided are the following settings for configuring the baseband filter:

Filter
Selects the baseband filter.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FILTer:TYPE on page 91

Roll Off Factor or BxT
Enters the filter parameters. The filter parameter offered (Roll Off factor or BxT)
depends on the currently selected filter type.

The rolloff factor affects the steepness of the filter slopes. A "Rolloff Factor = 0" results
in the steepest slopes; values near to 1 make the slopes more flat.

Figure 4-3: Example of the frequency response of a filter with different Roll Off Factors

This parameter is always set to the default for each of the predefined filters.

Filter / Clipping Settings



WLAN Configuration and SettingsR&S®SMW-K54/-K86

75User Manual 1175.6749.02 ─ 08

Remote command: 
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:APCO25 on page 92
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:COSine on page 92
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:GAUSs on page 92
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:PGAuss on page 93
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:RCOSine on page 94
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:SPHase on page 94

Cut Off Frequency Factor
Sets the value for the cut off frequency factor. The cut off frequency of the filter can be
adjusted to reach spectrum mask requirements.

Remote command: 
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:LPASs on page 93
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:LPASSEVM on page 93

Cut Off Frequency Shift
(available for filter parameter Cosine only.)

The cut off frequency is a filter characteristic that defines the frequency at the 3 dB
down point. The "Cut Off Frequency Shift" affects this frequency in the way that the fil-
ter flanks are "moved" and the transition band increases by "Cut Off Frequency
Shift"*"Sample Rate".
● A "Cut Off Frequency Shift" = -1 results in a very narrow-band filter
● Increasing the value up to 1 makes the filter more broad-band
● By "Cut Off Frequency Shift" = 0, the -3 dB point is at the frequency determined by

the half of the selected "Sample Rate".
Tip: Use this parameter to adjust the cut off frequency and reach spectrum mask
requirements.

Figure 4-4: Example of the frequency response of a filter with different Cut Off Frequency Shift

Remote command: 
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:COSine:COFS on page 92

Sample Rate Variation
Sets the sample rate of the signal.

Filter / Clipping Settings
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A variation of this parameter only affects the ARB clock rate; all other signal parame-
ters remain unchanged. If the sampling rate in the frame configuration menu is
changed, this parameter is reset to the chosen sampling rate.

Remote command: 
[:SOURce<hw>]:BB:WLNN:SRATe:VARiation on page 95

Sample Rate
Displays the sample rate of the signal specific for the selected bandwidth.

Remote command: 
[:SOURce<hw>]:BB:WLNN:SRATe? on page 94

4.14.2 Clipping Settings

► To access this dialog, select "Clipping".

The dialog comprises the settings, necessary to configure the clipping.

Provided are the following settings:

Clipping State
Switches baseband clipping on and off.

Baseband clipping is a very simple and effective way of reducing the crest factor of the
signal. Since clipping is done prior to filtering, the procedure does not influence the
spectrum. The EVM however increases.

WLAN signals may have very high crest factors. High crest factors entail two basic
problems:
● The nonlinearity of the power amplifier (compression) causes intermodulation

which expands the spectrum (spectral regrowth).
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● Since the level in the D/A converter is relative to the maximum value, the average
value is converted with a relatively low resolution. This results in a high quantiza-
tion noise.

Both effects increase the adjacent-channel power.

With baseband clipping, all the levels are limited to a settable value ("Clipping Level").
This level is specified as a percentage of the highest peak value. Since clipping is done
prior to filtering, the procedure does not influence the spectrum. The EVM however
increases.

Since clipping the signal not only changes the peak value but also the average value,
the effect on the crest factor is unpredictable. The following table shows the effect of
the "Clipping" on the crest factor for typical scenarios.

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLIPping:STATe on page 91

Clipping Level
Sets the limit for clipping.

This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLIPping:LEVel on page 90

Clipping Mode
Selects the clipping method. A graphic illustration of the way in which these two meth-
ods work is given in the dialog.
● "Vector | i + jq |"

The limit is related to the amplitude | i + q |. The I and Q components are mapped
together, the angle is retained.

● "Scalar | i | , | q |"
The limit is related to the absolute maximum of all the I and Q values | i | + | q |.
The I and Q components are mapped separately, the angle changes.

Remote command: 
[:SOURce<hw>]:BB:WLNN:CLIPping:MODE on page 90

Filter / Clipping Settings
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5 How to Work with the IEEE 802.11 WLAN
Option
The R&S SMW equipped with the option digital standard IEEE 802.11 WLAN allows
you to generate signals for different transmitter and receiver tests scenarios.

The following step-by-step instructions provide examples of some typical generic work-
flows and setups for working with this options.

5.1 Generating a 160 MHz 2x2 WLAN 802.11ac Signal

The IEEE 802.11ac uses MIMO technology, up to 160 MHz bandwidth and special
coding for increased throughput. The following options are required for the generation
of such a signal:

● option R&S SMW-B13T for a two path instrument .
● two frequency options R&S SMW-B10x/ 20x
● two options R&S SMW-K522 for the baseband extension to 160 MHz RF bandwith.
● two options WLAN IEEE802.11ac R&S SMW-K86
● (optional) two options Fading Simulator R&S SMW-B14
● (optional) option Fading MIMO R&S SMW-K74
● (optional) option AWGN R&S SMW-K62

The following step-by step instruction describes how to configure the instrument for
generating a 160 MHz 2x2 WLAN 802.11ac signal.

Configure the R&S SMW for a 160 MHz 2x2 MIMO WLAN 802.11ac signal genera-
tion

1. Configure the basebands in the "System Configuration > Fading/Baseband Config"
dialog to generate a 1x2x2 coupled sources signal.
For a detailed description of how to do that, refer to the R&S SMW user manual.

2. Configure the reference oscillator settings, depending on whether an external refer-
ence source is provided.
Select "External Reference Frequency Source" and configure the "Synchronization
Bandwidth" and the "External Reference Frequency" accordingly.

3. Set the power level and the frequency in the header display of the instrument.

4. Select an "IEEE 802.11 WLAN > Trigger in > Source > External Global Trigger".

5. In the "IEEE 802.11 WLAN > General > Transmit Antenna Setup" dialog set the
transmit antennas:

a) Set "Antennas > = 2".
b) Set "Output > O1 > Baseband A" and "Output > O2 > Baseband B".
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6. Set "IEEE 802.11 WLAN > General > Transmission Bandwith > 160 MHz ".

7. Set the frame block in the "IEEE 802.11 WLAN > Frame Block Configuration" dia-
log:

a) Set "Std.> 11ac".
b) Set the required "Type" and "Physical Mode" of the frame block.
c) Set "Tx Mode > VHT-160 MHz".
d) For "Type > Data" and "Physical Mode > Mixed Mode" set "Data > A-MPDU".
e) Set "State > ON".
f) Use the default "IEEE 802.11 WLAN > Frame Block Configuration > PPDU

Configuration" settings or adjust them if necessary to, for instance, add redun-
dancy.

8. Enable the WLAN 802.11ac signal generation.

9. (optional)
The signal can be additionally fed to a fading simulator.
An example of how to configure the fading simulator is given below. For a detailed
description, refer to the R&S SMW user manual.

a) In the "Fading" configuration dialog select "General > Standard > 802.11ac-
MIMO > Modell A".

b) Set "State > On".

10. (optional)
In the block diagram select "AWGN > On".
For a detailed description of how to do that, refer to the R&S SMW user manual.

11. In the block diagram select "RF A > On" and "RF B > On".
For a detailed description of how to do that, refer to the R&S SMW user manual.

5.2 Generating a 3x3 MIMO WLAN 802.11n Signal with a
R&S SMW for Transmitter Tests

This example shows the connection and configuration of the instrument for the genera-
tion of a 3x3 MIMO WLAN 802.11n signal for transmitter tests.

The 3x3 MIMO WLAN 802.11n signal generation scenario requires one two-path
instrument and a signal generator that provides the third RF Path, like the R&S SGS.

● option R&S SMW-B13T for a two path instrument .
● two frequency options R&S SMW-B10x/ 20x
● two options R&S SMW-K522 for the baseband extension to 160 MHz RF bandwith.
● two options WLAN IEEE802.11n R&S SMW-K54
● (optional) four options Fading Simulator R&S SMW-B14
● (optional) option Fading MIMO R&S SMW-K74
● (optional) option AWGN R&S SMW-K62
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The instruments have to be configured and connected as described in the following
section.

Connecting a R&S SGS and a R&S SMW for 3x3 MIMO WLAN 802.11n signal gen-
eration

Connect the instruments as described below:

1. Connect the I OUT 1/Q OUT 1 connectors of the R&S SMW to the I IN / Q IN con-
nectors of the R&S SGS.

2. To provide the R&S SGS with reference frequency, connect the input REF IN of
the instrument to the "REF OUT" connector of the R&S SMW.

3. Provide an external trigger signal to the input USER 3 of the R&S SMW.

4. Avoid unnecessary cable lengths and branching points.

The figure below shows the cabling of a two-path R&S SMW and a R&S SGS for
the generation of a 3x3 MIMO WLAN 802.11n signal.

Figure 5-1: Setup for tests with three antennas (Example of R&S SMW and a R&S SGS)

Configure the R&S SMW for 3x3 MIMO WLAN 802.11n signal generation

1. Connect the R&S SGS in the "System Configuration > External RF and I/Q > I/Q
OUT 1 > External Instrument > Config...".
For a detailed description of how to do that, refer to the R&S SMW user manual.

2. Configure the basebands in the "System Configuration > Fading/Baseband Config"
dialog to generate a 1x3x3 coupled source signal.
For a detailed description of how to do that, refer to the R&S SMW user manual.

3. Configure the reference oscillator settings, depending on whether an external refer-
ence source is provided.
Select "External Reference Frequency Source" and configure the "Synchronization
Bandwidth" and the "External Reference Frequency" accordingly.
For a detailed description of how to do that, refer to the R&S SMW user manual.

Generating a 3x3 MIMO WLAN 802.11n Signal with a R&S SMW for Transmitter Tests
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4. Set the power level and the frequency in the header display of the instrument.

5. Select an "IEEE 802.11 WLAN > Trigger in > Source > External Global Trigger 1".

6. In the "IEEE 802.11 WLAN > General > Transmit Antenna Setup" dialog set the
transmit antenna:

a) Set "Antennas > =3".
b) Set "Output > O1 > Baseband A", "Output > O2 > Baseband B" and "Output >

O3 > Baseband C".

7. To enable the R&S SMW to generate a WLAN 802.11n/802.11ac signal of anten-
nas with different power level, set the power level of the corresponding path to the
desired level in the header display of the instrument.

8. Set the frame block in the "IEEE 802.11 WLAN > Frame Block Configuration" dia-
log:

a) Set "Std.> 11n".
b) Set the required "Type" and "Physical Mode" of the frame block.
c) Set "State > ON".
d) Use the default "IEEE 802.11 WLAN > Frame Block Configuration > PPDU

Configuration" settings or adjust them if necessary to, for instance, add redun-
dancy.

9. Enable the WLAN 802.11n signal generation.

10. (optional)
The signal can be additionally fed to a fading simulator.
An example of how to configure the fading simulator is given below. For a detailed
description, refer to the R&S SMW user manual.

a) In the "Fading" configuration dialog select "General > Standard > 802.11n-
MIMO > Modell A".

b) Set "State > On".

11. (optional)
In the block diagram select "AWGN > On".
For a detailed description of how to do that, refer to the R&S SMW user manual.

12. In the block diagram select "I/Q Analog A > On", "RF A > On" and "RF B > On".
For a detailed description, refer to the R&S SMW user manual.

5.3 Generating a Realistic MxN MIMO WLAN 802.11n/ac/p
Signal for Receiver Test under Static Conditions

This example shows you how to enable the R&S SMW to generate a WLAN 802.11n/
802.11ac/802.11p signal for simple diversity and simulation of frequency flat MIMO
channel conditions. No additional channel simulator is necessary for this test applica-
tion.
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The figure below shows an example of a simple diversity scenario with three transmis-
sion antennas Tx 1 .. Tx 3 and one receiving antenna Rx 1. The channel is represen-
ted by the weight coefficients w1 .. w3.

The R&S SMW provides the possibility to weight, sum and map the generated Tx
antenna signals to the output(s) of the signal generator, i.e. to simulate a frequency flat
MIMO channel conditions for single carrier analysis e.g. BER tests.

To generate a realistic WLAN 802.11n/802.11ac/802.11p MIMO signal under static
conditions, configure the instrument(s) as follows:

1. In the "Frame Block Configuration" dialog set the "Std." for the required standard.

2. Use the default "Frame Block Configuration" settings or adjust them as required.

3. Use the default "PPDU Configuration" settings or adjust them if necessary to, for
instance, add redundancy.

4. In the "Tx Antenna Setup" dialog, select the number of "Tx Antennas" to be simula-
ted. The number of the Tx Antennas determines the value M in the MxN MIMO sys-
tem and the number of the transmission chains.

5. Configure the subcarrier to be analyzed, i.e. configure the "Spatial Mapping Mode"
and set the "Time Shifts".

Generating a Realistic MxN MIMO WLAN 802.11n/ac/p Signal for Receiver Test under Static Conditions
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6. In the Tx Antenna Setup dialog, enable the Baseband A to generate the Rx 1 sig-
nal.

7. Select the mapping coordinates and adjust the weights of the Tx signals in the
Transmission Chain Matrix.

8. To enable the R&S SMW to generate a WLAN 802.11n/802.11ac/802.11p signal of
antennas with different power level, set the power level of the corresponding path
to the desired level in the header display of the instrument.

9. Enable signal generation.

The Baseband A of the R&S SMW will generate the Rx signal as a sum of the three Tx
signals, weighted with the selected coefficients.

5.4 Generating a Realistic MxN MIMO WLAN 802.11n/ac/p
Signal for Receiver Test under Real Word Conditions

The simulation of real-time MIMO channel condition requires instruments equipped
with the fading options R&S SMW-K74/-B14.
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The instrument(s) have to be configured as follows:

1. Enable the instrument to generate a 2xN, 3xN or 4xN MIMO WLAN 802.11n/
802.11ac/802.11p signal as described in Chapter 5.2, "Generating a 3x3 MIMO
WLAN 802.11n Signal with a R&S SMW for Transmitter Tests", on page 79.

2. Enable the instrument to generate 2xN, 3xN or 4xN MIMO fading signal. Refer to
section "Multiple Input Multiple Output" in the description of the Fading Simulator.

Generating a Realistic MxN MIMO WLAN 802.11n/ac/p Signal for Receiver Test under Real Word Conditions
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6 Remote-Control Commands
The following commands are required to perform signal generation with the IEEE
802.11 WLAN options in a remote environment. We assume that the R&S SMW has
already been set up for remote operation in a network as described in the R&S SMW
documentation. A knowledge about the remote control operation and the SCPI com-
mand syntax are assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S SMW user manual.

The SOURce:BB:WLNN subsystem contains commands for the primary and general
settings of the IEEE 802.11 WLAN standard. These settings concern activation and
deactivation of the standard, setting the transmission direction, filter, clock, trigger and
clipping settings, defining the frame duration and the sequence length, as well as the
preset setting.

The commands for defining the frame configuration for physical layer modes OFDM
and CCK/PBCC are described in the next section. The commands are divided up in
this way to make the comprehensive SOURce:BB:WLNN subsystem clearer.

Common Suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

ENTity<ch> 1 .. 4 entity in a multiple entity configuration

ENTity3|4 require option R&S SMW-K76

SOURce<hw> [1]|4 available baseband signals

OUTPut<ch> 1 .. 3 available markers

FBLock<ch> [1]...100 available frame blocks

MPDU<st> 1...10 available MPDUs

Using SCPI command aliases for advanced mode with multiple entities
You can address multiple entities configurations by using the SCPI commands starting
with the keyword SOURce or the alias commands starting with the keyword ENTity.

Note that the meaning of the keyword SOURce<hw> changes in the second case.

For details, see section "SCPI Command Aliases for Advanced Mode with Multiple
Entities" in the R&S SMW user manual.

The following commands specific to the IEEE 802.11 WLAN are described here:
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6.1 General Commands

[:SOURce<hw>]:BB:WLNN:BWidth....................................................................................86
[:SOURce<hw>]:BB:WLNN:FBLock:APPend.......................................................................86
[:SOURce<hw>]:BB:WLNN:IFBLock.................................................................................. 86
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:INSert.................................................................. 86
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:COPY.................................................................. 87
[:SOURce<hw>]:BB:WLNN:CFBLock.................................................................................87
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DELete................................................................ 87
[:SOURce<hw>]:BB:WLNN:DFBLock.................................................................................87
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PASTe.................................................................87
[:SOURce<hw>]:BB:WLNN:PFBLock................................................................................. 87
[:SOURce<hw>]:BB:WLNN:PRESet...................................................................................87
[:SOURce<hw>]:BB:WLNN:SETTing:CATalog?.................................................................. 88
[:SOURce<hw>]:BB:WLNN:SETTing:DELete......................................................................88
[:SOURce<hw>]:BB:WLNN:SETTing:LOAD........................................................................88
[:SOURce<hw>]:BB:WLNN:SETTing:STORe......................................................................89
[:SOURce<hw>]:BB:WLNN:STATe.................................................................................... 89
[:SOURce<hw>]:BB:WLNN:WAVeform:CREate.................................................................. 89

[:SOURce<hw>]:BB:WLNN:BWidth <BWidth>

The command selects the transmission bandwidth. Whenever the bandwidth changes
from a higher to a lower one, the frame blocks are validated because some of them
could be invalid in the lower bandwidth (invalid TX Mode).

Parameters:
<BWidth> BW20 | BW40 | BW80 | BW160

*RST: BW20
Default unit: MHz

Example: BB:WLNN:BW BW40
sets the transmission bandwidth to 40 MHz.

Manual operation: See "Transmission Bandwidth" on page 19

[:SOURce<hw>]:BB:WLNN:FBLock:APPend

The command appends a frame block to the end of the frame blocks list.

Example: BB:WLNN:FBL:APP
appends a frame block to the end of the frame blocks list.

Usage: Event

Manual operation: See "Append" on page 36

[:SOURce<hw>]:BB:WLNN:IFBLock <IfBlock>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:INSert
The command adds a default frame block before the selected frame block.

 

General Commands
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Example: BB:WLNN:FBL2:INS
inserts a default frame block before the selected frame block.

Usage: Event

Manual operation: See "Insert" on page 36

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:COPY
[:SOURce<hw>]:BB:WLNN:CFBLock <CfBlock>

Copies the selected frame block.

Setting parameters: 
<CfBlock> integer

Range: 1  to  100

Example: BB:WLNN:CFBL 5
copies frame block 5 for later insertion.

Usage: Setting only

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DELete
[:SOURce<hw>]:BB:WLNN:DFBLock <DfBlock>

Deletes the selected frame block.

Setting parameters: 
<DfBlock> integer

Range: 1  to  100

Example: BB:WLNN:DFBL 10
deletes the selected frame block.

Usage: Setting only

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PASTe
[:SOURce<hw>]:BB:WLNN:PFBLock <PfBlock>

Pastes the selected frame block.

Setting parameters: 
<PfBlock> integer

Range: 1  to  99

Example: BB:WLNN:PFBL 20
pastes the frame block to row 20.

Usage: Setting only

[:SOURce<hw>]:BB:WLNN:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

General Commands
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Not affected is the state set with the command SOURce<hw>:BB:WLNN:STATe.

Example: SOURce:BB:WLNN:PRESet
Usage: Event

Manual operation: See "Set to Default" on page 17

[:SOURce<hw>]:BB:WLNN:SETTing:CATalog?

The command reads out the files with IEEE 802.11 settings in the default directory.
The default directory is set using command MMEM:CDIRectory. Only files with the file
extension *.wlann will be listed.

Return values: 
<Catalog> string

Example: MMEM:CDIR '/var/user/temp/wlann'
sets the default directory to /var/user/temp/wlann.
BB:WLNN:SETT:CAT?
reads out all the files with IEEE 802.11 settings in the default
directory.
Response: 'wlann_1','wlann_2'
the files ''wlann1' and 'wlann2'' are available.

Usage: Query only

Manual operation: See "Save/Recall" on page 19

[:SOURce<hw>]:BB:WLNN:SETTing:DELete <Filename>

The command deletes the selected file with IEEE 802.11 WLAN settings. The directory
is set using command MMEM:CDIRectory. A path can also be specified, in which
case the files in the specified directory are read. The file extension may be omitted.
Only files with the file extension *.wlann are listed and can be deleted.

Setting parameters: 
<Filename> string

Example: BB:WLNN:SETT:DEL 'wlann_1'
deletes file 'wlann_1'.

Usage: Setting only

Manual operation: See "Save/Recall" on page 19

[:SOURce<hw>]:BB:WLNN:SETTing:LOAD <Filename>

The command loads the selected file with IEEE 802.11 WLAN settings. The directory is
set using command MMEM:CDIRectory. A path can also be specified, in which case
the files in the specified directory are read. The file extension may be omitted. Only
files with the file extension *.wlann will be loaded.
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Setting parameters: 
<Filename> string

Example: BB:WLNN:SETT:LOAD 'wlann_1'
loads file 'wlann_1'.

Usage: Setting only

Manual operation: See "Save/Recall" on page 19

[:SOURce<hw>]:BB:WLNN:SETTing:STORe <Filename>

The command stores the current IEE 802.11 WLAN settings into the selected file. The
directory is set using command MMEM:CDIRectory. A path can also be specified, in
which case the files in the specified directory are read. Only the file name has to be
entered. IEE 802.11 WLAN settings are stored as files with the specific file extensions
*.wlann.

Setting parameters: 
<Filename> string

Example: BB:WLNN:SETT:STOR 'wlann_1'
stores the current settings into file 'wlann_1'.

Usage: Setting only

Manual operation: See "Save/Recall" on page 19

[:SOURce<hw>]:BB:WLNN:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SOURce1:BB:WLNN:STATe ON
Manual operation: See "State" on page 17

[:SOURce<hw>]:BB:WLNN:WAVeform:CREate <Filename>

This command creates a waveform using the current settings of the "WLAN" menu.
The file name is entered with the command. The file is stored with the predefined file
extension *.wv. The file name and the directory it is stored in are user-definable.

Setting parameters: 
<Filename> string

Example: MMEM:CDIR '/var/user/temp/waveform'
sets the default directory to /var/user/temp/waveform.
BB:WLNN:WAV:CRE 'wlann_1'
creates the waveform file wlann_1.wv in the default directory.
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Usage: Setting only

Manual operation: See "Generate Waveform File" on page 19

6.2 Filter/Clipping Settings

[:SOURce<hw>]:BB:WLNN:CLIPping:LEVel....................................................................... 90
[:SOURce<hw>]:BB:WLNN:CLIPping:MODE...................................................................... 90
[:SOURce<hw>]:BB:WLNN:CLIPping:STATe......................................................................91
[:SOURce<hw>]:BB:WLNN:FILTer:TYPE........................................................................... 91
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:APCO25..................................................... 92
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:COSine.......................................................92
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:COSine:COFS.............................................92
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:GAUSs....................................................... 92
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:LPASs........................................................ 93
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:LPASSEVM.................................................93
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:PGAuss...................................................... 93
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:RCOSine.....................................................94
[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:SPHase...................................................... 94
[:SOURce<hw>]:BB:WLNN:SRATe?.................................................................................. 94
[:SOURce<hw>]:BB:WLNN:SRATe:VARiation.....................................................................95

[:SOURce<hw>]:BB:WLNN:CLIPping:LEVel <Level>

Sets the limit for level clipping. This value indicates at what point the signal is clipped.
It is specified as a percentage, relative to the highest level. 100% indicates that clip-
ping does not take place.

Level clipping is activated with the command SOUR:BB:WLNN:CLIP:STAT ON
Parameters:
<Level> integer

Range: 1 PCT  to  100 PCT
Increment: 1 PCT
*RST: 100 PCT

Example: BB:WLNN:CLIP:LEV 80PCT
sets the limit for level clipping to 80% of the maximum level.
BB:WLNN:CLIP:STAT ON
activates level clipping.

Manual operation: See "Clipping Level" on page 77

[:SOURce<hw>]:BB:WLNN:CLIPping:MODE <Mode>

The command sets the method for level clipping (Clipping).
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Parameters:
<Mode> VECTor | SCALar

VECTor
The reference level is the amplitude | i+jq |.
SCALar
The reference level is the absolute maximum of the I and Q val-
ues.
*RST: VECTor

Example: BB:WLNN:CLIP:MODE SCAL
selects the absolute maximum of all the I and Q values as the
reference level.
BB:WLNN:CLIP:LEV 80PCT
sets the limit for level clipping to 80% of this maximum level.
BB:WLNN:CLIP:STAT ON
activates level clipping.

Manual operation: See "Clipping Mode" on page 77

[:SOURce<hw>]:BB:WLNN:CLIPping:STATe <State>

The command activates level clipping (Clipping). The value is defined with the com-
mand [SOURce:]BB:WLNN:CLIPping:LEVel, the mode of calculation with the com-
mand [SOURce:]BB:WLNN:CLIPping:MODE.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:WLNN:CLIP:STAT ON
activates level clipping.

Manual operation: See "Clipping State" on page 76

[:SOURce<hw>]:BB:WLNN:FILTer:TYPE <Type>

The command selects the filter type.

Parameters:
<Type> RCOSine | COSine | GAUSs | LGAuss | CONE | COF705 |

COEQualizer | COFequalizer | C2K3x | APCO25 | SPHase |
RECTangle | PGAuss | LPASs | DIRac | ENPShape |
EWPShape | LPASSEVM
*RST: Depends on layer mode

Example: BB:WLNN:FILT:TYPE COS
sets the filter type COSine.

Manual operation: See "Filter" on page 74
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[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:APCO25 <Apco25>

Sets the roll-off factor for filter type APCO25.

Parameters:
<Apco25> float

Range: 0.05  to  0.99
Increment: 0.01
*RST: 0.2

Example: BB:WLNN:PAR:APCO25 0.2
sets the roll-off factor to 0.2 for filter type APCO25.

Manual operation: See "Roll Off Factor or BxT" on page 74

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:COSine <Cosine>

Sets the roll-off factor for the Cosine filter type.

Parameters:
<Cosine> float

Range: 0  to  1
Increment: 0.01
*RST: 0.35

Example: BB:WLNN:PAR:COS 0.35
sets the roll-off factor to 0.35 for filter type Cosine.

Manual operation: See "Roll Off Factor or BxT" on page 74

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:COSine:COFS <CoFs>

The command sets the "cut of frequency shift' value for the Cosine filter type.

Parameters:
<CoFs> float

Range: -1  to  1
Increment: 0.01
*RST: 0

Example: BB:WLNN:FILT:PAR:COS:COFS 0.04
the "cut of frequency shift" value is set to 0.04.

Manual operation: See "Cut Off Frequency Shift" on page 75

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:GAUSs <Gauss>

Sets the roll-off factor for the Gauss filter type.
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Parameters:
<Gauss> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.5

Example: BB:WLNN:PAR:GAUS 0.5
sets B x T to 0.5 for the Gauss filter type.

Manual operation: See "Roll Off Factor or BxT" on page 74

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:LPASs <LPass>

Sets the cut off frequency factor for the Lowpass (ACP optimization) filter type.

Parameters:
<LPass> float

Range: 0.05  to  2
Increment: 0.01
*RST: 0.5

Example: BB:WLNN:FILT:PAR:LPAS 0.5
the cut of frequency factor is set to 0.5.

Manual operation: See "Cut Off Frequency Factor" on page 75

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:LPASSEVM <LPassevm>

Sets the cut off frequency factor for the Lowpass (EVM optimization) filter type.

Parameters:
<LPassevm> float

Range: 0.05  to  2
Increment: 0.01
*RST: 0.5

Example: BB:WLNN:FILT:PAR:LPASSEVM 0.5
the cut of frequency factor is set to 0.5.

Manual operation: See "Cut Off Frequency Factor" on page 75

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:PGAuss <PGauss>

Sets the roll-off factor for the Pure Gauss filter type.

Parameters:
<PGauss> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.5
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Example: BB:WLLN:FILT:PAR:PGAUS 0.5
sets B x T to 0.5 for the Pure Gauss filter type.

Manual operation: See "Roll Off Factor or BxT" on page 74

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:RCOSine <RCosine>

Sets the roll-off factor for the Root Cosine filter type.

Parameters:
<RCosine> float

Range: 0  to  1
Increment: 0.01
*RST: 0.22

Example: BB:WLNN:PAR:RCOS 0.22
sets the roll-off factor to 0. 22 for filter type Root Cosine.

Manual operation: See "Roll Off Factor or BxT" on page 74

[:SOURce<hw>]:BB:WLNN:FILTer:PARameter:SPHase <SPhase>

Sets B x T for the Split Phase filter type.

Parameters:
<SPhase> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 2

Example: BB:WLNN:PAR:SPH 0.5
sets B x T to 0.5 for the Split Phase filter type.

Manual operation: See "Roll Off Factor or BxT" on page 74

[:SOURce<hw>]:BB:WLNN:SRATe?

Displays the sample rate specific for the selected bandwidth ([:SOURce<hw>]:BB:
WLNN:BWidth).

Return values: 
<SampRate> float

20MHz for BW20, 60MHz for BW40.

Usage: Query only

Manual operation: See "Sample Rate" on page 19
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[:SOURce<hw>]:BB:WLNN:SRATe:VARiation <Variation>

Parameters:
<Variation> float

Range: 400 Hz  to  40 MHz
Increment: 0.001 Hz
*RST: 2 MHz
Default unit: Hz (c/s)

Example: BB:WLNN:SRAT:VAR 4000000
sets the output sample rate to 4 MHz.

Manual operation: See "Sample Rate Variation" on page 75

6.3 Trigger Settings

This section lists the remote control commands, necessary to configure the trigger.

[:SOURce<hw>]:BB:WLNN:TRIGger:ARM:EXECute............................................................95
[:SOURce<hw>]:BB:WLNN:TRIGger:EXECute....................................................................96
[:SOURce<hw>]:BB:WLNN:TRIGger:EXTernal:SYNChronize:OUTPut.................................. 96
[:SOURce<hw>]:BB:WLNN:TRIGger:OBASeband:DELay.................................................... 96
[:SOURce<hw>]:BB:WLNN:TRIGger:OBASeband:INHibit.................................................... 97
[:SOURce<hw>]:BB:WLNN:TRIGger:RMODe?................................................................... 97
[:SOURce<hw>]:BB:WLNN:TRIGger:SLENgth.................................................................... 98
[:SOURce<hw>]:BB:WLNN:TRIGger:SLUNit.......................................................................98
[:SOURce<hw>]:BB:WLNN:TRIGger:SOURce.................................................................... 99
[:SOURce<hw>]:BB:WLNN:TRIGger[:EXTernal]:DELay....................................................... 99
[:SOURce<hw>]:BB:WLNN:TRIGger[:EXTernal]:INHibit....................................................... 99
[:SOURce<hw>]:BB:WLNN[:TRIGger]:SEQuence..............................................................100

[:SOURce<hw>]:BB:WLNN:TRIGger:ARM:EXECute

The command stops signal generation for trigger modes Armed_Auto and Armed_Ret-
rigger. A subsequent internal or external trigger event restart signal generation.

Example: BB:WLNN:TRIG:SOUR INT
sets internal triggering.
BB:WLNN:TRIG:SEQ ARET
sets Armed_Retrigger mode, i.e. every trigger event causes sig-
nal generation to restart.
BB:WLNN:TRIG:EXEC
executes a trigger, signal generation is started.
BB:WLNN:TRIG:ARM:EXEC
signal generation is stopped.
BB:WLNN:TRIG:EXEC
executes a trigger, signal generation is started again.

Usage: Event

Manual operation: See "Arm" on page 22
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[:SOURce<hw>]:BB:WLNN:TRIGger:EXECute

The command executes a trigger. The internal trigger source must be selected using
the command BB:WLNN:TRIG:SOUR INT and a trigger mode other than AUTO must
be selected using the command BB:WLNN:TRIG:SEQ.

Example: BB:WLNN:TRIG:SOUR INT
sets internal triggering.
BB:WLNN:TRIG:SEQ RETR
sets Retrigger mode, i.e. every trigger event causes signal gen-
eration to restart.
BB:WLNN:TRIG:EXEC
executes a trigger.

Usage: Event

Manual operation: See "Execute Trigger" on page 22

[:SOURce<hw>]:BB:WLNN:TRIGger:EXTernal:SYNChronize:OUTPut <Output>

(enabled for Trigger Source External)

Enables/disables output of the signal synchronous to the external trigger event.

Parameters:
<Output> 0 | 1 | OFF | ON

ON
The signal calculation starts simultaneously with the external
trigger event but because of the instrument's processing time
the first samples are cut off and no signal is outputted. After
elapsing of the internal processing time, the output signal is syn-
chronous to the trigger event.
OFF
The signal output begins after elapsing of the processing time
and starts with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequen-
ces with signal duration comparable with the processing time of
the instrument.
*RST: ON

Example: BB:WLNN:TRIG:SOUR EXT
sets external triggering.
BB:WLNN:TRIG:EXT:SYNC:OUTP ON
enables synchrounous output to external trigger

Manual operation: See "Sync. Output to External Trigger" on page 23

[:SOURce<hw>]:BB:WLNN:TRIGger:OBASeband:DELay <Delay>

Specifies the trigger delay (expressed as a number of samples) for triggering by the
trigger signal from the second path.
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Parameters:
<Delay> float

Range: 0  to  16777215
Increment: 0.01
*RST: 0

Example: BB:WLNN:TRIG:SOUR OBAS
sets for path A the internal trigger executed by the trigger signal
from the second path (path B).
BB:WLNN:TRIG:INH 200
sets a restart inhibit for 200 samples following a trigger event.

Manual operation: See "Trigger Delay" on page 24

[:SOURce<hw>]:BB:WLNN:TRIGger:OBASeband:INHibit <Inhibit>

Specifies the number of samples by which a restart is to be inhibited following a trigger
event. This command applies only for triggering by the second path.

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0

Example: BB:WLNN:TRIG:SOUR OBAS
sets for path A the internal trigger executed by the trigger signal
from the second path (path B).
BB:WLNN:TRIG:INH 200
sets a restart inhibit for 200 samples following a trigger event.

Manual operation: See "External Trigger Inhibit" on page 24

[:SOURce<hw>]:BB:WLNN:TRIGger:RMODe?

The command queries the current status of signal generation for all trigger modes with
IEEE 802.11 WLAN modulation on.

Return values: 
<RMode> RUN | STOP

RUN
the signal is generated. A trigger event occurred in the triggered
mode.
STOP
the signal is not generated. A trigger event did not occur in the
triggered modes, or signal generation was stopped by the com-
mand :BB:WLNN:TRIG:ARM:EXECute (armed trigger modes
only).
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Example: BB:WLNN:TRIG:SOUR EXT
sets external triggering.
BB:WLNN:TRIG:MODE ARET
selects the Armed_Retrigger mode.
BB:WLNN:TRIG:RMOD?
queries the current status of signal generation.
Response: RUN
the signal is generated, an external trigger was executed.

Usage: Query only

Manual operation: See "Running/Stopped" on page 22

[:SOURce<hw>]:BB:WLNN:TRIGger:SLENgth <Slength>

The command defines the length of the signal sequence to be output in the "Single"
trigger mode (SOUR:BB:WLNN:SEQ SING). The input is made in terms of samples.

It is possible to output deliberately just part of the frame, an exact sequence of the
frame, or a defined number of repetitions of the frame.

Parameters:
<Slength> integer

Range: 1  to  (2^32) - 1
*RST: 1
Default unit: sample

Example: BB:WLNN:SEQ SING
sets trigger mode Single.
BB:WLNN:TRIG:SLEN 200
sets a sequence length of 200 samples. The first 200 samples of
the current frame will be output after the next trigger event.

Manual operation: See "Trigger Signal Duration" on page 22

[:SOURce<hw>]:BB:WLNN:TRIGger:SLUNit <Slunit>

The command defines the unit for the entry of the length of the signal sequence
(SOUR:BB:WLNN:TRIG:SLEN) to be output in the Single trigger mode
(SOUR:BB:WLNN:SEQ SING).

Parameters:
<Slunit> SAMPle | SEQuence

SAMPle
Unit Sample. A single sample is generated after a trigger event.
SEQuence
Unit Sequence Length. A single sequence is generated after a
trigger event.
*RST: SEQuence
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Example: BB:WLNN:SEQ SING
sets trigger mode Single.
BB:WLNN:TRIG:SLUN SEQ
sets unit Sequence for the entry of sequence length.
BB:WLNN:TRIG:SLEN 2
sets a sequence length of 2 sequences. Two sequences will be
output after the next trigger event.

Manual operation: See "Signal Duration Unit" on page 22

[:SOURce<hw>]:BB:WLNN:TRIGger:SOURce <Source>

Selects the trigger signal source and determines the way the triggering is executed.
Provided are internal triggering by means of a command, external trigger singnal via
one of the provided local or global connectors and and triggering by a signal from the
other paths.

Parameters:
<Source> INTB | INTernal | OBASeband | EGT1 | EGT2 | EGC1 | EGC2 |

ELTRigger | INTA | ELCLock | BEXTernal | EXTernal
*RST: INTernal

Example: BB:WLNN:TRIG:SOUR INT
selects an internal trigger source.

Manual operation: See "Trigger Source" on page 22

[:SOURce<hw>]:BB:WLNN:TRIGger[:EXTernal]:DELay <Delay>

Sets the trigger delay.

Parameters:
<Delay> float

Range: 0  to  16777215
Increment: 0.01
*RST: 0
Default unit: samples

Example: BB:WLNN:TRIG:SOUR EXT
selects an external trigger.
BB:WLNN:TRIG:EXT:DEL 50
sets a delay of 50 symbols for the trigger.

Manual operation: See "Trigger Delay" on page 24

[:SOURce<hw>]:BB:WLNN:TRIGger[:EXTernal]:INHibit <Inhibit>

Specifies the number of samples by which a restart is to be inhibited following an exter-
nal trigger event.
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Parameters:
<Inhibit> integer

Range: 0  to  21.47*sampRate
*RST: 0

Example: BB:WLNN:TRIG:SOUR EXT
selects an external trigger.
BB:WLNN:TRIG:EXT:INH 200
sets a restart inhibit for 200 samples following a trigger event.

Manual operation: See "External Trigger Inhibit" on page 24

[:SOURce<hw>]:BB:WLNN[:TRIGger]:SEQuence <Sequence>

Selects the trigger mode.

Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

AUTO
The modulation signal is generated continuously.
RETRigger
The modulation signal is generated continuously. A trigger event
(internal or external) causes a restart.
AAUTo
The modulation signal is generated only when a trigger event
occurs. After the trigger event the signal is generated continu-
ously. Signal generation is stopped with command
SOUR:BB:WLNN:TRIG:ARM:EXEC and started again when a
trigger event occurs.
ARETrigger
The modulation signal is generated only when a trigger event
occurs. The device automatically toggles to RETRIG mode.
Every subsequent trigger event causes a restart.
Signal generation is stopped with command
SOUR:BB:WLNN:TRIG:ARM:EXEC and started again when a
trigger event occurs.
SINGle
The modulation signal is generated only when a trigger event
occurs. Then the signal is generated once to the length specified
with command SOUR:BB:WLNN:TRIG:SLEN. Every subsequent
trigger event causes a restart.
*RST: AUTO

Example: BB:WLNN:SEQ AAUT
sets the Armed_auto trigger mode; the device waits for the first
trigger (e.g. with *TRG) and then generates the signal continu-
ously.

Manual operation: See "Trigger Mode" on page 21
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6.4 Marker Settings

This section lists the remote control commands, necessary to configure the markers.

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut:DELay:FIXed............................................... 101
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay................................................. 101
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay:MAXimum?................................102
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay:MINimum?.................................102
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:MODE................................................. 103
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:ONTime............................................... 104
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:OFFTime............................................. 104
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FBINdex...............................................104
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FINDex................................................ 104
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FESHift................................................ 105
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:RESHift................................................105
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PATTern.............................................. 105
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PULSe:DIVider..................................... 106
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PULSe:FREQuency?.............................106

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut:DELay:FIXed <Fixed>

The command restricts the marker delay setting range to the dynamic range. In this
range the delay can be set without restarting the marker and signal. If a delay is
entered in setting ON but is outside this range, the maximum possible delay is set and
an error message is generated.

Parameters:
<Fixed> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:WLNN:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.

Manual operation: See "Marker x Delay" on page 29

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay <Delay>

Defines the delay between the signal on the marker outputs and the start of the signal,
expressed in terms of samples. Command :BB:WLNN:TRIGger:OUTPut:DELay:
FIXed can be used to restrict the range of values to the dynamic range, i.e. the range
within which a delay of the marker signals can be set without restarting the marker and
signal.

Parameters:
<Delay> float

Range: 0  to  (2^32) -1
Increment: 1E-3
*RST: 0
Default unit: sample
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Example: BB:WLNN:TRIG:OUTP:DEL 1600
sets a delay of 1600 samples for the corresponding marker sig-
nal.

Manual operation: See "Marker x Delay" on page 29

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay:MAXimum?

The command queries the maximum marker delay for set-
ting :BB:WLNN:TRIG:OUTP:DEL:FIX ON.

Return values: 
<Maximum> float

Example: BB:WLNN:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.
BB:WLNN:TRIG:OUTP:DEL:MAX
queries the maximum of the dynamic range.
Response: 2000
the maximum for the marker delay setting is 2000 samples.

Usage: Query only

Manual operation: See "Marker x Delay" on page 29

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:DELay:MINimum?

The command queries the minimum marker delay for set-
ting :BB:WLNN:TRIGger:OUTPut:DELay:FIXed ON.

Return values: 
<Minimum> float

Example: BB:WLNN:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.
BB:WLNN:TRIG:OUTP:DEL:MIN?
queries the minimum of the dynamic range.
Response: 0
the minimum for the marker delay setting is 0 samples.

Usage: Query only

Manual operation: See "Marker x Delay" on page 29
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[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:MODE <Mode>

Parameters:
<Mode> RESTart | FBLock | FRAMe | FAPart | PULSe | PATTern |

RATio | FIPart
RESTart
A marker signal is generated at the start of each signal
sequence (period = all frame blocks).
FRAMe
Number of Frame Blocks = 1, that is, a marker signal is gener-
ated at the start of each frame in the single frame block. Other-
wise, the frame block and frame index are entered and the spe-
cific frame is masked.
FBLock
Number of Frame Blocks = 1, that is, a marker signal is gener-
ated at the start of each frame block. Otherwise, a specific frame
block index is given and the whole frame block is marked.
FAPart
Number of Frame Blocks = 1, that is, a marker signal is gener-
ated to mark every active part of each frame.
The active data transfer part (PPDU) of a frame period is
marked with high, the inactive part (idle time) with low. This
marker can be used to decrease the carrier leakage during inac-
tive signal parts by feeding it into the pulse modulator.
Otherwise, the frame block and frame index are entered and the
active part of the specific frame is masked.
PATTern
A marker signal is generated according to the user defined pat-
tern (command
SOURce:BB:WLNN:TRIGger:OUTPut:PATTern).

PULSe
A pulsed marker signal is generated. The pulse frequency
(= symbol rate/divider) is defined with the
SOUR:BB:WLNN:TRIG:OUTP:PULSe:DIVider command and
can be queried with the
SOUR:BB:WLNN:TRIG:OUTP:PULSe:FREQuency? command.

RATio
A marker signal corresponding to the Time Off / Time On specifi-
cations in the commands
SOURce:BB:WLNN:TRIGger:OUTPut:OFFT and
"SOURce:BB:WLNN:TRIGger:OUTPut:ONT" is generated.
*RST: RESTart

Example: BB:WLNN:TRIG:OUTP:MODE FRAM
selects the frame marker for the corresponding marker signal.

Manual operation: See "Marker Mode" on page 26
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[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:ONTime <OnTime>
[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:OFFTime <OffTime>

The command sets the number of samples in a period (ON time + OFF time) during
which the marker signal in setting SOURce:BB:WLNN:TRIGger:OUTPut:MODE
RATio on the marker outputs is OFF.

Parameters:
<OffTime> integer

Range: 1  to  16777215
*RST: 1

Example: BB:WLNN:TRIG:OUTP:OFFT 200
sets an OFF time of 200 samples for the corresponding marker
signal.

Manual operation: See "Marker Mode" on page 26

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FBINdex <FbIndex>

The command sets the frame block index. For this/these frame block(s), a marker sig-
nal is generated. The maximum value depends on the number of the currently active
frame blocks (max = 100).

Parameters:
<FbIndex> integer

Range: 0  to  100
Increment: 1
*RST: 1

Example: BB:WLNN:TRIG:OUTP1:FBIN 5
sets the frame block index to 5.

Manual operation: See "Marker Mode" on page 26

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FINDex <FIndex>

The command sets the frame index, that is, the frame to be marked in the frame block
marked with command BB:WLNN:TRIGger:OUTPut:FBIndex. The maximum value
depends on the number of frames set with command BB:WLNN:FBLock:FCOunt. The
maximum value is 1024.

Parameters:
<FIndex> integer

Range: 1  to  1024
Increment: 1
*RST: 1

Example: BB:WLNN:TRIG:OUTP1:FIND 100
sets the frame index to 100.

Manual operation: See "Marker Mode" on page 26
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[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:FESHift <Shift>

Shifts the falling edge of the marker the specified number of samples. Negative values
result in a shift back of the marker edge.

Parameters:
<Shift> integer

Range: -100  to  100
*RST: 0

Example: BB:WLNN:TRIG:OUTP2:FESH 75
Manual operation: See "Marker Mode" on page 26

shifts the falling edge of the marker 2 about 75 samples.

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:RESHift <Shift>

Shifts the rising edge of the marker the specified number of samples. Negative values
result in a shift back of the marker edge.

Parameters:
<Shift> integer

Range: -100  to  100
*RST: 0

Example: BB:WLNN:TRIG:OUTP2:RESH -20

Manual operation: See "Marker Mode" on page 26

shifts back the rising edge of marker 2 about 20 samples.

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PATTern <Pattern>

The command defines the bit pattern used to generate the marker signal in the setting
SOURce:BB:WLNN:TRIGger:OUTPut:MODE PATTern.

0 is marker off

1 is marker on

Parameters:
<Pattern> 64 bits

*RST: #H2,2

Example: BB:WLNN:TRIG:OUTP2:PATT #B000000011111111,15
sets a bit pattern.
BB:WLNN:TRIG:OUTP:MODE PATT
activates the marker signal according to a bit pattern for the cor-
responding marker signal.

Manual operation: See "Marker Mode" on page 26
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[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

The command sets the divider for Pulse marker mode (SOUR:BB:WLNN:TRIG:OUTP:
MODE PULSe). The resulting pulse frequency is derived by dividing the symbol rate by
the divider.

Parameters:
<Divider> integer

Range: 2  to  1024
Increment: 1
*RST: 2

Example: BB:WLNN:TRIG:OUTP:PULS:DIV 2
sets the divider to 2 for the corresponding marker signal.
BB:WLNN:TRIG:OUTP2:FREQ?
queries the resulting pulse frequency of the marker signal.
Response: 66 000
the resulting pulse frequency is 66 kHz.

Manual operation: See "Marker Mode" on page 26

[:SOURce<hw>]:BB:WLNN:TRIGger:OUTPut<ch>:PULSe:FREQuency?

The command queries the pulse frequency of the pulsed marker signal in the setting
SOURce:BB:WLNN:TRIGger:OUTPut:MODE PULSe. The pulse frequency is derived
by dividing the symbol rate by the divider.

Return values: 
<Frequency> float

Example: BB:WLNN:TRIG:OUTP:PULS:DIV 2
sets the divider marker signal of the corresponding marker sig-
nal to the value 2.
BB:WLNN:TRIG:OUTP:MODE PULS
enables the pulsed marker signal.
BB:WLNN:TRIG:OUTP:PULS:FREQ?
queries the pulse frequency of the marker signal.
Response: 33 000
the resulting pulse frequency is 33 kHz.

Usage: Query only

Manual operation: See "Marker Mode" on page 26

6.5 Clock Settings

This section lists the remote control commands, necessary to configure the clock.

[:SOURce<hw>]:BB:WLNN:CLOCk:MODE....................................................................... 107
[:SOURce<hw>]:BB:WLNN:CLOCk:MULTiplier................................................................. 107
[:SOURce<hw>]:BB:WLNN:CLOCk:SOURce....................................................................107
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[:SOURce<hw>]:BB:WLNN:CLOCk:MODE <Mode>

Sets the type of externally supplied clock.

Parameters:
<Mode> SAMPle | MSAMple

*RST: SAMPle

Example: SOURce1:BB:WLNN:CLOCk:MODE SAMPle
selects clock type

Manual operation: See "Clock Mode" on page 31

[:SOURce<hw>]:BB:WLNN:CLOCk:MULTiplier <Multiplier>

Note: This command is available for clock source "External" and in clock mode "Multi-
ple Sample" only.

Specifies the multiplier for clock type "Multiplied" (:BB:WLNN:CLOCk:MODE MSAMple)
in the case of an external clock source.

Parameters:
<Multiplier> integer

Range: 1  to  64
Increment: 1
*RST: 4

Example: SOURce1:BB:WLNN:CLOCk:SOURce EGC1
selects the external clock source.
SOURce1:BB:WLNN:CLOCk:MODE MSAMple
selects clock type "Multiplied", i.e. the supplied clock has a rate
which is a multiple of the sample rate.
SOURce1:BB:WLNN:CLOCk:MULTiplier 12
the multiplier for the external clock rate is 12.

Manual operation: See "Clock Multiplier" on page 31

[:SOURce<hw>]:BB:WLNN:CLOCk:SOURce <Source>

Selects the clock source.

Clock Settings
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Parameters:
<Source> INTernal | EGC1 | EGC2 | ELCLock | EXTernal

INTernal
The instrument uses its internal clock reference
EGC1|EGC2
External global clock
ELCLock
External local clock
EXTernal
EXTernal = EGC1
Setting only; provided for backward compatibility with other R&S
signal generators.
*RST: INTernal

Example: BB:WLNN:CLOC:SOUR: INT
selects an internal clock reference.

Manual operation: See "Clock Source" on page 30

6.6 Antenna Configuration Settings

[:SOURce<hw>]:BB:WLNN:ANTenna:MODE....................................................................108
[:SOURce<hw>]:BB:WLNN:ANTenna:SYSTem.................................................................108
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:DESTination............................109
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:FSELect..................................109
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:REAL......................................110
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:IMAGinary...............................110
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:PHASe....................................110
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:MAGNitude............................. 110

[:SOURce<hw>]:BB:WLNN:ANTenna:MODE <Mode>

The command selects the number of transmit antennas to be used.

Parameters:
<Mode> A1 | A2 | A3 | A4 | A5 | A6 | A7 | A8

*RST: A1

Example: BB:WLNN:ANT:MODE A1
one antenna is used for transmission.

Manual operation: See "Antennas" on page 37

[:SOURce<hw>]:BB:WLNN:ANTenna:SYSTem <System>

The command selects the coordinate system of the transmission chain matrix.
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Parameters:
<System> CARTesian | CYLindrical

*RST: CARTesian

Example: BB:WLNN:ANT:SYST CART
sets the coordinate system of the transmission chain matrix to
Cartesian.

Manual operation: See "Mapping Coordinates" on page 37

[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:DESTination
<Destination>

The command selects the destination of the calculated IQ chains.

Parameters:
<Destination> OFF | BB | BB_B | FILE

OFF
No mapping takes place.
BB
The IQ chain is output to the baseband A. Exactly one output
stream can be mapped as "Baseband A".
BB_B
The IQ chain is output to the baseband B. Exactly one output
stream can be mapped as "Baseband B".
FILE
The IQ chain is saved in a file.
*RST: OFF (for antenna 2 .. 8); Baseband (for antenna 1)

Example: BB:WLNN:ANT:TCH1:OUTP:DEST BB
the IQ chain is saved in a file.

Manual operation: See "Output" on page 38

[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:FSELect <FSelect>

The command saves the IQ chain in a file.

Suffix: 
<ch>

.
[1] .. 8

Parameters:
<FSelect> string

Example: BB:WLNN:ANT:TCH1:OUTP:FSEL
'/var/user/temp/wlnn_1.wv'
saves the IQ chain in the selected file.

Manual operation: See "Output" on page 38
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[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:REAL <Real>

Sets the value for the Real coordinate.

Parameters:
<Real> float

Range: -1000  to  1000
Increment: 0.01

Example: BB:WLNN:ANT:TCH1:TX2:REAL 500
sets the real coordinate for the selected transmission chain to
500.

Manual operation: See "Real/Magnitude" on page 38

[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:IMAGinary
<Imaginary>

Sets the value for the Imaginary coordinate.

Parameters:
<Imaginary> float

Range: -999.99  to  999.99
Increment: 0.01
*RST: 0

Example: BB:WLNN:ANT:TCH1:TX2:IMAG 500
sets the imaginary coordinate for the selected transmission
chain to 500.

Manual operation: See "Imaginary/Phase" on page 38

[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:PHASe <Phase>

Sets the phase when cylindrical mapping coordinates are selected.

Parameters:
<Phase> float

Range: 0  to  359.99
Increment: 0.01
*RST: 0

Manual operation: See "Imaginary/Phase" on page 38

[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:MAGNitude
<Magnitude>

Sets the magnitude when cylindrical mapping coordinates are selected.
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Parameters:
<Magnitude> float

Range: 0  to  999.99
Increment: 0.01

Manual operation: See "Real/Magnitude" on page 38

6.7 Frame Block Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BOOSt...............................................................111
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:FCOunt..............................................................112
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA.................................................................112
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:DSELection...............................................112
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:PATTern...................................................113
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:RATE?..................................................... 113
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ITIMe.................................................................113
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PMODe..............................................................114
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STANdard.......................................................... 114
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STATe............................................................... 115
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TMODe..............................................................115
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TYPE.................................................................116
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:COPY................................................................ 116
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DELete.............................................................. 116
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:INSert................................................................ 116
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PASTe...............................................................116
[:SOURce<hw>]:BB:WLNN:FBLock:APPend.....................................................................117

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BOOSt <Boost>

The command assigns a specific RMS power boost/attenuation to the corresponding
Frame Block Modulation.

The power level of a Frame Block Modulation is calculated as sum of the power boost
and the power level set in the header of the instrument.

Note: At least one Frame Block should have a power boost set to 0 dB value for this
gated power mode functionality to work properly.

Parameters:
<Boost> float

Range: -80  to  0
Increment: 0.01
*RST: 0
Default unit: dB

Example: BB:WLNN:FBL5:BOOS -10.0
sets the power boost

Manual operation: See "Boost /dB" on page 36
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:FCOunt <FCount>

The command sets the number of frames to be transmitted in the current frame block.

Parameters:
<FCount> integer

Range: 1  to  20 000
Increment: 1
*RST: 1

Example: BB:WLNN:FBL5:FCO 1
sets the number of transmitted frames in the current frame block
to 1.

Manual operation: See "Frames" on page 35

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA <Data>

Selects the data source.

Parameters:
<Data> ZERO | ONE | PATTern | PN9 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt | AMPDU
PNxx
The pseudo-random sequence generator is used as the data
source. Different random sequence lengths can be selected.
DLISt
A data list is used. The data list is selected with the command
BB:WLNN:FBLocks:DATA:DSEL
ZERO | ONE
Internal 0 and 1 data is used.
PATTern
Internal data is used. The bit pattern for the data is defined by
the command BB:WLNN:FBLocks:DATA:PATTern.

AMPDU
Aggregated mac protocol data unit (A-MPDU) data is used as
configured with the commands in Chapter 6.8.2, "MPDU Config-
uration", on page 131
*RST: PN9

Example: BB:WLNN:FBL5:DATA PN9
sets PN9 as the data source.

Manual operation: See "Data" on page 35

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:DSELection <DSelection>

The command selects the data list for the DLISt data source selection.
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The lists are stored as files with the fixed file extensions *.dm_iqd in a directory of the
user's choice. The directory applicable to the following commands is defined with the
command MMEMory:CDIR. To access the files in this directory, you only have to give
the file name without the path and the file extension.

Parameters:
<DSelection> string

Example: BB:WLNN:FBL5:DATA DLIS
selects the Data Lists data source.
MMEM:CDIR '/var/user/temp/Lists_DM'
selects the directory for the data lists.
BB:WLNN:FBL5:DATA:DSEL 'dlist1'
selects file 'dlist1' as the data source. This file must be in the
directory /var/user/temp/Lists_DM and have the file exten-
sion *.dm_iqd.

Manual operation: See "Data" on page 35

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:PATTern <Pattern>

The command determines the bit pattern for the PATTern selection. The maximum
length is 64 bits.

Parameters:
<Pattern> 64 bits

*RST: #H0,1

Example: BB:WLNN:FBL5:DATA:PATT #H3F,8
sets the bit pattern.

Manual operation: See "Data" on page 35

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:RATE?

The command queries the PPDU data rate.

Return values: 
<Rate> float

Example: BB:WLNN:FBL5:DATA:RATE?
queries the data rate.

Usage: Query only

Manual operation: See "Data Rate/Mbps" on page 36

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ITIMe <ITime>

Sets the time interval separating two frames in this frame block. The default unit for the
time interval are seconds. However, the time interval can be set in milliseconds. In this
case the unit has to be set.
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Parameters:
<ITime> float

Range: 0  to  1
Increment: 100E-6
*RST: 100E-6

Example: BB:WLNN:FBL5:ITIMe 0.0025
sets the idle time to 2.5 msec.

Manual operation: See "Idle Time / ms" on page 35

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PMODe <PMode>

Selects the preamble design.

For physical type SOUNDING, only GREEN FIELD is available.

Parameters:
<PMode> LEGacy | MIXed | GFIeld

LEGacy
Compatible with 802.11 a/g OFDM devices.
MIXed
For High Throughput (HT) and 802.11a/g OFDM devices.
GRFIled
For HT only networks.
*RST: MIXed

Example: BB:WLNN:FBL5:PMOD LEG
sets the physical mode to LEGACY.

Manual operation: See "Physical Mode" on page 33

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STANdard <Standard>

Sets the IEEE 802.11 WLAN standard.
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Parameters:
<Standard> USER | WAG | WBG | WPJ | WN | WAC

USER
Sets a user defined standard.
WAG
Sets the IEEE 802.11a/g standard.
WBG
Sets the IEEE 802.11b/g standard.
WCG
Sets the IEEE 802.11c/g standard.
WPJ
Sets the IEEE 802.11p/j standard.
WN
Sets the IEEE 802.11n standard.
WAC
Sets the IEEE 802.11a/c standard.
*RST: USER

Example: BB:WLNN:FBL1:STAN WN
sets the IEEE 802.11n standard

Manual operation: See "Standard" on page 32

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STATe <State>

The command enables the corresponding frame block for transmission.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: ON

Example: BB:WLNN:FBL5:STAT ON
enables frame block 5 for transmission.

Manual operation: See "State" on page 36

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TMODe <TMode>

The command sets the Tx mode. The available Tx modes are dependent on the physi-
cal mode.

Parameters:
<TMode> L20 | LDUP | LUP | LLOW | HT20 | HT40 | HTDup | HTUP |

HTLow | CCK | PBCC | V20 | V40 | V80 | V160 | V8080 | L10
*RST: HT20

Example: BB:WLNN:FBL5:TMOD HT40
sets the Tx mode to HT 40 MHz.

Manual operation: See "Tx Mode" on page 33

Frame Block Configuration



Remote-Control CommandsR&S®SMW-K54/-K86

116User Manual 1175.6749.02 ─ 08

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TYPE <Type>

The command selects the PPDU type.

Parameters:
<Type> DATA | SOUNding | BEACon

DATA
Only Data Long Training Fields are used to probe the channel.
SOUNding
Staggered preambles are used to probe additional dimension of
the MIMO channel. Only Physical Layer Mode GREEN FIELD is
available.
BEACon
Frame type "Beacon" is used to probe the channel.
*RST: DATA

Example: BB:WLNN:FBL5:TYPE DATA
sets the PPDU type data.

Manual operation: See "Type" on page 33

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:COPY

Usage: Event

Manual operation: See "Copy" on page 36

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DELete

Deletes the specified frame block.

Usage: Event

Manual operation: See "Delete" on page 36

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:INSert

The command adds a default frame block before the selected frame block.

Example: BB:WLNN:FBL2:INS
inserts a default frame block before the selected frame block.

Usage: Event

Manual operation: See "Insert" on page 36

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PASTe

Usage: Event

Manual operation: See "Paste" on page 37
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[:SOURce<hw>]:BB:WLNN:FBLock:APPend

The command appends a frame block to the end of the frame blocks list.

Example: BB:WLNN:FBL:APP
appends a frame block to the end of the frame blocks list.

Usage: Event

Manual operation: See "Append" on page 36

6.8 Frame Configuration Settings

6.8.1 Frame Block PPDU Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CBINonht........................................................... 118
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:ENCoder?..............................................118
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:RATE.................................................... 118
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:TYPE.................................................... 119
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:BPSymbol?...............................................119
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:LENGth.................................................... 119
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:RATE?..................................................... 120
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:SYMBols.................................................. 120
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DBINonht........................................................... 120
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ESSTream......................................................... 121
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:GUARd.............................................................. 121
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ILEaver:STATe................................................... 121
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MCS.................................................................. 121
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MODulation<st>..................................................122
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MUMimo:STATe................................................. 122
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MU<st0>:GID..................................................... 122
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MU<st0>:NSTS...................................................123
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:NTPS.................................................................123
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PAID:PATTern....................................................123
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PLCP:FORMat....................................................124
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PLCP:LCBit:STATe.............................................124
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PREamble:STATe...............................................125
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:BRATe.....................................................125
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:BSPReading:STATe..................................125
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:MODulation?............................................ 126
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:MODE..............................................126
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:PATTern...........................................127
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SEGMent........................................................... 127
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SERVice:PATTern.............................................. 128
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMOothing......................................................... 128
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SSTReam.......................................................... 129
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STBC:STATe?....................................................129
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STSTream..........................................................129
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TDWindowing:STATe.......................................... 130
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TTIMe................................................................130
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:UINDex..............................................................130

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CBINonht <CBINonht>

(avaliable only for VHT Tx mode)

The command is used to modify the first 7 bits of the scrambling sequence to indicate
the duplicated bandwidth of the PPDU.

Parameters:
<CBINonht> B20 | B40 | B80 | B160 | OFF

B20|B40|B80|B160
Indicates 20 MHz, 40MHz, 80MHz or 160 (80+80) MHz channel
bandwidth of the transmitted packet.
OFF
Channel bandwidth in Non HT is not present.
*RST: OFF
Default unit: MHz

Example: BB:WLNN:FBL1:CBIN B80
selects 80 MHz channel bandwidth of the transmitted packet.

Manual operation: See "Ch. Bandwidth in Non HT" on page 45

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:ENCoder?

Queries the number of encoders to be used. This value depends on the data rate. For
data rate ≤ 300 Mps, this value is 1. Otherwise the number of encoders is 2.

Return values: 
<Encoder> E1 | E2 | E3 | E6 | E7 | E8 | E9 | E12 | E4 | E5 | E10 | E11

Example: BB:WLNN:FBL5:COD:ENC?
queries the number of encoders to be used.

Usage: Query only

Manual operation: See "Encoders" on page 42

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:RATE <Rate>

This command selects the coding rate.

Parameters:
<Rate> CR1D2 | CR2D3 | CR3D4 | CR5D6

*RST: CR1D2

Example: BB:WLNN:FBL5:COD:RATE CR1D2
sets the coding rate to CR1D2.
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Manual operation: See "Cod Rate" on page 42

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:CODing:TYPE <Type>

Selects the channel coding.

Parameters:
<Type> OFF | BCC | LDPC

*RST: BCC

Example: BB:WLNN:FBL5:COD:TYPE OFF
no channel coding is used.

Manual operation: See "Channel Coding" on page 42

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:BPSymbol?

Queries the number of data bits sent by an OFDM symbol on all spatial streams.

Return values: 
<BpSymbol> integer

*RST: 0

Example: BB:WLNN:FBL5:DATA:BPS?
queries the number of data bits sent by an OFDM symbol on all
spatial streams.

Usage: Query only

Manual operation: See "Data Bits Per Symbol" on page 42

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:LENGth <Length>

The command enters the size of the data field in bytes.

For Data Length = 0, no data field will be generated for the case of a sounding frame.

The maximum data length depends on the physical mode: In LEGACY mode, the max-
imum value is 4061 Bytes. In MIXED MODE and GREEN FIELD, the maximum value
is 65495 Bytes.

The data length is related to the number of data symbols. Whenever the data length
changes, the number of data symbols is updated and vice versa.

Parameters:
<Length> integer

Range: 0  to  Max
*RST: 1024 (for LEGACY); 1048575 (for GREEN FIELD

or MIXED MODE)

Example: BB:WLNN:FBL5:DATA:LENG 500
sets the data length to 500 Bytes.

Manual operation: See "Data Length" on page 44
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:RATE?

The command queries the PPDU data rate.

Return values: 
<Rate> float

Example: BB:WLNN:FBL5:DATA:RATE?
queries the data rate.

Usage: Query only

Manual operation: See "Data Rate/Mbps" on page 36

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DATA:SYMBols <Symbols>

Sets the number of data symbols per frame block.

If the number of OFDM data symbols is changed, the generator calculates the data
field length as a function of the set PPDU bit rate and displays it at Data Length.

Parameters:
<Symbols> integer

Range: 1  to  Max
*RST: 158

Example: BB:WLNN:FBL5:DATA:SYMB 1
sets the number of data symbols per frame block to 1.

Manual operation: See "Number Of Data Symbols" on page 46

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:DBINonht <DBINonht>

(avaliable only for VHT Tx mode)

This command is used to modify the first 7 bits of the scrambling sequence to indicate
if the transmitter is capable of "Static" or "Dynamic" bandwidth operation.

Parameters:
<DBINonht> STAT | DYN | OFF

STAT
The transmitter is capable of static bandwidth operation.
DYN
The transmitter is capable of dynamic bandwidth operation.
OFF
Dynamic bandwidth in Non HT is not present.
*RST: OFF

Example: BB:WLNN:FBL1:DBIN DYN
the transmitter is capable of dynamic bandwidth operation.

Manual operation: See "Dyn. Bandwidth in Non HT" on page 46
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ESSTream <EsStream>

Sets the value of the extended spatial streams. This field is active for frame block type
SOUNDING only to probe additional dimensions to the channel.

Parameters:
<EsStream> integer

Range: 1  to  dynamic
Increment: 1
*RST: 1

Example: BB:WLNN:FBL5:ESSTR 4
sets the number of the extended spatial streams to 4.

Manual operation: See "Extended Spatial Streams" on page 40

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:GUARd <Guard>

The command selects whether a long or short guard interval is used for the OFDM
guard. In physical mode GREEN FIELD or LEGACY, only long guard intervals are pos-
sible. In this case, the field is read-only.

Parameters:
<Guard> SHORt | LONG

*RST: LONG

Example: BB:WLNN:FBL5:GUAR LONG
sets a long guard interval.

Manual operation: See "Guard" on page 42

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:ILEaver:STATe <State>

The command activates/deactivates the interleaver of the data field.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: ON

Example: BB:WLNN:FBL5:ILE:STAT ON
activates the interleaver.

Manual operation: See "Interleaver Active" on page 45

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MCS <MCS>

The command selects the modulation and coding scheme for all spatial streams.
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Parameters:
<MCS> MCS0 | MCS1 | MCS2 | MCS3 | MCS4 | MCS5 | MCS6 | MCS7 |

MCS8 | MCS9 | MCS10 | MCS11 | MCS12 | MCS13 | MCS14 |
MCS15 | MCS16 | MCS17 | MCS18 | MCS19 | MCS20 |
MCS21 | MCS22 | MCS23 | MCS24 | MCS25 | MCS26 |
MCS27 | MCS28 | MCS29 | MCS30 | MCS31 | MCS32 |
MCS33 | MCS34 | MCS35 | MCS36 | MCS37 | MCS38 |
MCS39 | MCS40 | MCS41 | MCS42 | MCS43 | MCS44 |
MCS45 | MCS46 | MCS47 | MCS48 | MCS49 | MCS50 |
MCS51 | MCS52 | MCS53 | MCS54 | MCS55 | MCS56 |
MCS57 | MCS58 | MCS59 | MCS60 | MCS61 | MCS62 |
MCS63 | MCS64 | MCS65 | MCS66 | MCS67 | MCS68 |
MCS69 | MCS70 | MCS71 | MCS72 | MCS73 | MCS74 |
MCS75 | MCS76
*RST: MCS1

Example: BB:WLNN:FBL1:MCS MCS8
selects MCS8 as the coding scheme used for the spatial stream.

Manual operation: See "MCS" on page 42

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MODulation<st> <Modulation>

The command selects the modulation used for the spatial stream.

Parameters:
<Modulation> BPSK | QPSK | QAM16 | QAM64 | QAM256

*RST: QPSK; BPSK for Tx Mode > HT-Duplicate

Example: BB:WLNN:FBL5:MOD1 BPSK
sets BPSK as the modulation mode used for the spatial stream.

Manual operation: See "Stream n" on page 42

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MUMimo:STATe <MUMimo>

Activates Multi User MIMO. This function applies to "Spatial Streams">1.

Parameters:
<MUMimo> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:BB:WLNN:FBL1:MUM:STAT ON
activates Multi User MIMO.

Manual operation: See "Multi User MIMO" on page 40

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MU<st0>:GID <GID>

Sets the group ID for all available users.
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Parameters:
<GID> integer

Range: 1  to  62
*RST: 1

Example: BB:WLNN:BB:WLNN:FBL1:MU1:GID 1.0
assigns group ID 1.0 to user 1.

Manual operation: See "Multi User MIMO Settings Table" on page 41

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MU<st0>:NSTS <NSTS>

Sets the number of space time streams for each user.

Parameters:
<NSTS> integer

Range: 0  to  Max
*RST: 1

Example: BB:WLNN:BB:WLNN:FBL1:MU2:NSTS 8.0
sets 8 space time streams for user 2.

Manual operation: See "Multi User MIMO Settings Table" on page 41

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:NTPS <NTPS>

(avaliable only for VHT Tx mode)

The command indicates whether VHT AP allows VHT non-AP STAs in TXOP power
save mode to enter during TXOP.

Parameters:
<NTPS> OFF | ON

ON
Indicates that the VHT AP allows VHT non-AP STAs to enter
doze mode during a TXOP.
OFF
Indicates that the VHT AP does not allow VHT non-AP STAs to
enter doze mode during a TXOP.
*RST: 1

Example: BB:WLNN:FBL1:NTPS ON
activates NTPS.

Manual operation: See "No TXOP PS" on page 48

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PAID:PATTern <Pattern>

(avaliable only for VHT Tx mode)

The command provides an abbreviated indication of the intended recipient(s) of the
frame.
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Parameters:
<Pattern> 9 bits

*RST: #H000,9

Example: BB:WLNN:FBL1:PAID:PAT #H1FB,9
sets the pattern.

Manual operation: See "Partial AID (hex)" on page 47

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PLCP:FORMat <Format>

(available only for CCK and PBCC transport modes)

Selects the packet type (PPDU format) with long or short PLCP (physical layer conver-
gence protocol).

Depending on the format selected, the structure, modulation and data rate of the PLCP
preamble and header are modified.

Parameters:
<Format> LONG | SHORt

*RST: LONG

Example: BB:WLNN:FBL5:PMOD LEG
sets the physical mode to LEGACY.
BB:WLNN:FBL5:TMOD CCK
sets the transport mode
BB:WLNN:FBL5:PLCP:FORM SHOR
sets the PLCP Format

Manual operation: See "PLCP P+H Format " on page 47

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PLCP:LCBit:STATe <State>

(available only for CCK and PBCC transport modes)

Sets the Locked Clock Bit in Service Field of the PLCP Header.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: ON

Example: BB:WLNN:FBL5:PMOD LEG
sets the physical mode to LEGACY.
BB:WLNN:FBL5:TMOD CCK
sets the transport mode
BB:WLNN:FBL5:PLCP:LCB:STAT OFF
sets the Locked Clock Bit

Manual operation: See "Service Field Clock Bit " on page 47
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PREamble:STATe <State>

The command activates/deactivates the preamble and signal fields of the frames in the
current frame block. For data type = SOUNDING, the preamble and signal field are
always activated and cannot be deactivated.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: BB:WLNN:FBL5:PRE:STAT ON
activates the preamble and signal fields of the frames in the cur-
rent frame block.

Manual operation: See "Preamble/Header Active" on page 47

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:BRATe <BRate>

(available only for CCK and PBCC transport modes)

Sets the PSDU bit rate.

Parameters:
<BRate> P1MBPS | P2MBPS | P5.5MBPS | P11MBPS | P22MBPS

*RST: 11E6

Example: BB:WLNN:FBL5:PMOD LEG
sets the physical mode to LEGACY.
BB:WLNN:FBL5:TMOD CCK
sets the transport mode
BB:WLNN:FBL5:PSDU:BRAT P2MBPS
sets the PSDU bit rate

Manual operation: See "PSDU Bit Rate" on page 43

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:BSPReading:STATe <State>

(available only for CCK and PBCC transport modes)

Enables/disables Barker spreading.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: BB:WLNN:FBL5:PMOD LEG
sets the physical mode to LEGACY.
BB:WLNN:FBL5:TMOD CCK
sets the transport mode
BB:WLNN:FBL5:PSDU:BRAT 2MBPS
sets the PSDU bit rate
BB:WLNN:FBL5:PSDU:BSPR:STAT ON
enables spreading
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Manual operation: See "Barker Spreading" on page 44

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:PSDU:MODulation?

(available only for CCK and PBCC Tx modes)

The command queries the modulation type. The modulation mode depends on the
selected PSDU bit rate which depends on the selected physical layer mode
(SOUR:BB:WLNN:MODE).

Return values: 
<Modulation> BPSK | QPSK | DBPSK | DQPSK | CCK | PBCC

*RST: CCK

Example: BB:WLNN:FBL5:PMOD LEG
sets the physical mode to LEGACY.
BB:WLNN:FBL5:TMOD CCK
sets the transport mode
BB:WLNN:FBL5:PSDU:BRAT P2MBPS
sets the PSDU bit rate
BB:WLNN:PSDU:MOD?
queries the modulation mode.
Response: "DQPSK"

Usage: Query only

Manual operation: See "PSDU Modulation" on page 43

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:MODE <Mode>

The command selects the different options for the scrambler.
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Parameters:
<Mode> OFF | RANDom | USER | ON | PREamble

OFF
The scrambler is deactivated.
RANDom
(not for CCK/PBCC)
The scrambler is activated.
The initialization value of the scrambler is selected at random.
Each frame has a different random initialization value. This value
is also different in case of successive recalculations with the
same setting parameters so that different signals are generated
for each calculation.
USER
(not for CCK/PBCC)
The scrambler is activated.
The initialization value of the scrambler is set to a fixed value
that is set using the command BB:WLNN:FBL5:SCR:PATT. This
value is then identical in each generated frame.
ON
(CCK/PBCC only)
The scrambler is activated.
PREamble
(CCK/PBCC only)
The scrambler is activated. Only the preamble is scrambled.
*RST: USER

Example: BB:WLNN:FBL5:SCR:MODE RAND
activates the scrambler with an random initialization value.

Manual operation: See "Scrambler" on page 45

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SCRambler:PATTern <Pattern>

The command sets the initialization value for scrambling mode User. This value is then
identical in each generated frame.

Parameters:
<Pattern> 8 bits

*RST: #H01,8

Example: BB:WLNN:FBL5:SCR:PATT #H3F,8
sets the user defined initialization value for the scrambler.

Manual operation: See "Scrambler Init (hex)" on page 46

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SEGMent <SEGMent>

Selects one of the two segments in VHT-80+80 MHz mode with transmisssion band-
width 80 or 160 MHz. Both segments can only be generated with bandwidth 160 MHz.

Frame Configuration Settings



Remote-Control CommandsR&S®SMW-K54/-K86

128User Manual 1175.6749.02 ─ 08

This parameter applies to VHT-80+80 MHz Tx mode only.

Parameters:
<SEGMent> SEG0 | SEG1 | BOTH

*RST: SEG0

Example: BB:WLNN:FBL1:SEGM BOTH
selects both segments.

Manual operation: See "Segment" on page 40

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SERVice:PATTern <Pattern>

The command sets the value of the service field. The standard specifies a default
value of 0. Other values can be entered in hexadecimal form for test purposes or future
extensions.

Parameters:
<Pattern> 16 bits

*RST: #H0000,16

Example: BB:WLNN:FBL5:SERV:PATT #H3F,16
sets the value for the service field.

Manual operation: See "Service Field (hex)" on page 46

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMOothing <SMOothing>

(available for all Tx modes, except VHT)

This command indicates to the receiver whether frequency-domain smoothing is rec-
ommended as part of channel estimation.

Parameters:
<SMOothing> OFF | ON

ON
Indicates that channel estimate smoothing is recommended.
OFF
Indicates that only per-carrier independent channel
(unsmoothed) estimate is recommended.
*RST: 1

Example: BB:WLNN:FBL:SMO ON
switches on smoothing.

Manual operation: See "Smoothing" on page 47
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SSTReam <SStream>

The command sets the number of the spatial streams. For physical mode LEGACY,
only value 1 is valid. For Tx Mode "HT-Duplicate", only value 1 is valid. In all other
cases, the number of spatial streams depends on the number of antennas configured
with command SOURce:BB:WLNN:ANTenna:MODE.

Parameters:
<SStream> integer

Range: 1  to  8
*RST: 1

Example: BB:WLNN:FBL5:SSTR 4
sets the number of spatial streams to 4.

Manual operation: See "Spatial Streams" on page 40

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STBC:STATe?

The command queries the status of the space time block coding.

Return values: 
<State> INACtive | ACTive

Example: BB:WLNN:FBL5:STBC:STAT?
queries the status of the space time block coding.

Usage: Query only

Manual operation: See "Space Time Block Coding" on page 40

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:STSTream <Ststream>

The command sets the number of the space time streams. This value depends on the
number of spatial streams defined with command
SOURce:BB:WLNN:FBLock:SSTReam. Changing the number of the Spatial Streams
immediately changes the value of the Space Time Streams to the same value.

Parameters:
<Ststream> integer

Range: 1  to  dynamic
*RST: 1

Example: BB:WLNN:FBL5:STBC:STAT?
queries the status of the space time block coding.

Manual operation: See "Space Time Streams" on page 40
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TDWindowing:STATe <State>

The command activates/deactivates the time domain windowing. Time domain win-
dowing is a method to influence the spectral characteristics of the signal, which is not
stipulated by the standard. However, it does not replace oversampling and subsequent
signal filtering.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL5:TDW:STAT ON
activates the time domain windowing.

Manual operation: See "Time Domain Windowing Active" on page 46

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:TTIMe <TTime>

The command sets the transition time when time domain windowing is active.

The transition time defines the overlap range of two OFDM symbols. At a setting of 100
ns and if BW = 20 MHz, one sample overlaps.

Parameters:
<TTime> float

Range: 0  to  1000 ns
Increment: 1 ns
*RST: 100 ns

Example: BB:WLNN:FBL5:TTIM 100
sets the transition time to 100 ns.

Manual operation: See "Transition Time" on page 46

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:UINDex <UIND>

Defines the currently generated user. In activated Multi User MIMO only one user can
be generated at a time. This parameter selects the generated one out of four avaliable
users.

Parameters:
<UIND> UIDX0 | UIDX1 | UIDX2 | UIDX3

*RST: UIDX0

Example: BB:WLNN:BB:WLNN:FBL1:UIND UIDX1
selects the generated user with index 1.

Manual operation: See "User Index" on page 41
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6.8.2 MPDU Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU:COUNt.................................................... 131
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:DSELection..............................131
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:LENGth................................... 131
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:PATTern..................................132
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:SOURce.................................. 132
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU:EOF........................................................ 132

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU:COUNt <Count>

Determines the number of MPDUs in the frame.

Parameters:
<Count> integer

Range: 1  to  64
*RST: 1

Example: BB:WLNN:FBL1:MPDU:COUN 3
Determines the number of MPDUs in the frame.

Manual operation: See "Number of MPDUs" on page 48

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:DSELection
<Filename>

Selects the data list for the DLISt data source selection.

The lists are stored as files with the fixed file extensions *.dm_iqd in a directory of the
user's choice.

Parameters:

<Filename> string

Example: BB:WLNN:FBL1:MPDU1:DATA DLIS
Selects the Data Lists data source.
MMEM:CDIR '/var/user/temp/Lists'
Selects the directory for the data lists.
BB:WLNN:FBL1:MPDU1:DATA:DSEL 'dlist1'
Selects the 'dlist1' as the data source. This file must be in the
directory specified above. It must have the file extension
*.dm_iqd.

Manual operation: See "DList / Pattern" on page 49

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:LENGth <Length>

Determines the size of the data field in bytes.
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Parameters:
<Length> integer

Range: 0  to  16384
*RST: 1024

Example: BB:WLNN:FBL1:MPDU1:DATA:LENG 1024
Determines the size of the data field.

Manual operation: See "Data Length / bytes" on page 49

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:PATTern <Pattern>

Determines the bit pattern for the PATTern selection.

Parameters:
<Pattern> 64 bits

*RST: #H0,1

Example: BB:WLNN:FBL1:MPDU1:DATA:PATT #B0101,4
Sets the bit pattern.

Manual operation: See "DList / Pattern" on page 49

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU<st>:DATA:SOURce <Source>

Selects the data source.

Parameters:
<Source> ZERO | ONE | PATTern | PN9 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt
PNxx
The pseudo-random sequence generator is used as the data
source. Different random sequence lengths can be selected.
DLISt
A data list is used. The data list is selected with the command
BB:WLNN:FBL<ch>:MPDU<st>:DATA:DSEL
ZERO | ONE
Internal 0 or 1 data is used.
PATTern
Internal data is used. The bit pattern for the data is defined by
the command BB:WLNN:FBL<ch>:MPDU<st>:DATA:PATT.

*RST: PN9

Example: BB:WLNN:FBL1:MPDU1:DATA:SOUR PATT
Selects the data source.

Manual operation: See "Data" on page 49

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MPDU:EOF <EOF>

Sets the EOF value for the A-MPDU.
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Parameters:
<EOF> DEFault | E0 | E1

*RST: DEFault

Manual operation: See "EOF" on page 49

6.8.3 MAC Header Configuration

6.8.3.1 Common Fields Commands

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:ADDRess<st>.............................................133
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:ADDRess<st>:STATe..................................134
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:BSSid........................................................ 134
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:DID............................................................134
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol................................................... 134
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:FDS............................................ 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:MDATa........................................135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:MFRagments............................... 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:ORDer........................................ 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:PMANagement.............................135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:PVERsion....................................135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:RETRy........................................ 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:SUBType.....................................135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:TDS............................................ 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:TYPE.......................................... 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:WEP........................................... 135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SA.............................................................135
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCS:STATe................................................136
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:QSControl..................................................136
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:QSControl:STATe....................................... 136
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:INCRement................ 136
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:STARt........................137
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:INCRement.................137
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:STARt........................ 137
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:STATe........................................ 138
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:STATe....................................................... 138

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:ADDRess<st> <Address>

The command enters the value of the address fields 1 ... 4. Exactly 48 bits must be
entered. Each address is 6 bytes (48 bit) long. The addresses can be entered in hexa-
decimal form in the entry field of each address field. The least significant byte (LSB) is
in left notation.

Parameters:
<Address> integer

Range: #H000000000000,48  to  #HFFFFFFFFFFFF,48
*RST: #H000000000000,48
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Example: BB:WLNN:FBL1:MAC:ADDR2 #H124836C7EA54,48
set the value for address field 2.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:ADDRess<st>:STATe <State>

The command activates/deactivates the selected address field.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:WLNN:FBL1:MAC:ADDR2:STAT ON
activates generation of address field 2.

Manual operation: See "MAC Address" on page 55

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:BSSid <Bssid>

Sets the value of the basic service set identification (BSSID) field.

Parameters:
<Bssid> integer

Example: BB:WLNN:FBL1:MAC:BSS #H124836C7EA54,48
Sets the value of the BSSID field to 124836C7EA54

Manual operation: See "BSSID (hex)" on page 56

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:DID <Did>

The command enters the value of the duration ID field. Depending on the frame type,
the 2-byte field Duration/ID is used to transmit the association identity of the station
transmitting the frame or it indicates the duration assigned to the frame type. Exactly
16 bit must be entered.

Parameters:
<Did> integer

Range: #H0000,16  to  #HFFFF,16
*RST: #H0000,16

Example: BB:WLNN:FBL1:MAC:DID #HA5A5,16
sets the value of the duration ID field.

Manual operation: See "Duration Id" on page 55

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol <FControl>

The command enters the value of the frame control field. The frame control field has a
length of 2 bytes (16 bits) and is used to define the protocol version, the frame type,
and its function, etc.. As an alternative, the individual bits can be set with the following
commands.
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Parameters:
<FControl> integer

Range: #H0000,16  to  #HFFFF,16
*RST: #H0000,16

Example: BB:WLNN:FBL1:MAC:FCON #H100A,16
sets the value of the frame control field.

Manual operation: See "Frame Control" on page 55

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:FDS <Fds>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:MDATa <MData>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:MFRagments

<MFragments>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:ORDer <Order>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:PMANagement

<PManagement>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:PVERsion <PVersion>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:RETRy <Retry>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:SUBType <Subtype>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:TDS <Tds>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:TYPE <Type>
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCONtrol:WEP <Wep>

The command enters the value of the individual bits of the frame control field.

Parameters:
<Wep> integer

Range: #H0,1  to  #H1,1
*RST: #H0,1

Example: BB:WLNN:FBL1:MAC:FCON:MDAT #H1,1
sets the value of the More Data bit.

Manual operation: See "Frame Control" on page 55

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SA <Sa>

Sets the value of the source adress (SA) field.

Parameters:
<Sa> integer

Example: BB:WLNN:FBL1:MAC:SA #HFFFFFFFFFFFF,48
Sets the value of the SA field to FFFFFFFFFFFF.

Manual operation: See "SA (hex)" on page 56
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:FCS:STATe <State>

Activates/deactivates the calculation of the FCS (frame check sequence). The stan-
dard defines a 32-bit (4-byte) checksum to protect the MAC header and the user data
(frame body).

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:WLNN:FBL1:MAC:FCS:STAT ON
activates the calculation of the FCS.

Manual operation: See "FCS (checksum)" on page 55

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:QSControl <QsControl>

The command sets the value for the QoS control field.

Parameters:
<QsControl> integer

Range: #H0000,16  to  #HFFFF,16

Example: BB:WLNN:FBL1:MAC:QSC #H5A5A,16
stets the value for the QoS field.

Manual operation: See "QoS Control" on page 64

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:QSControl:STATe <State>

The command enables/disables the QoS control.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: ON

Example: BB:WLNN:FBL1:MAC:QSC:STAT ON
enables the QoS control.

Manual operation: See "QoS Control" on page 64

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:INCRement
<Increment>

Defines the number of packets required to increment the counter of the fragment bits of
the sequence control.

Parameters:
<Increment> integer

Range: 0  to  1024
*RST: 1
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Example: BB:WLNN:FBL1:MAC:SCON:FRAG:INCR 2
two packets are required to increment the counter of the frag-
ment bits.

Manual operation: See "Sequence Control" on page 56

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:FRAGment:STARt
<Start>

The command enters the start number of the fragment bits of the sequence control.

Parameters:
<Start> integer

Range: #H0,4  to  #HF,4
*RST: #H0,4

Example: BB:WLNN:FBL1:MAC:SCON:FRAG:STAR #H4,4
sets the start value of the fragment bits of the sequence control.

Manual operation: See "Sequence Control" on page 56

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:INCRement
<Increment>

Defines the number of packets required to increment the counter of the sequence bits
of the sequence control.

Parameters:
<Increment> integer

Range: 0  to  1024
*RST: 1

Example: BB:WLNN:FBL1:MAC:SCON:FRAG:INCR 2
two packets are required to increment the counter of the
sequence bits.

Manual operation: See "Sequence Control" on page 56

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:SEQuence:STARt
<Start>

The command enters the start number of the fragment bits of the sequence control.

Parameters:
<Start> integer

Range: #H000,12  to  #HFFF,12
*RST: #H000,12

Example: BB:WLNN:FBL1:MAC:SCON:SEQ:STAR #H444,12
sets the start value of the sequence bits of the sequence control.

Manual operation: See "Sequence Control" on page 56
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:SCONtrol:STATe <State>

The command activates/deactivates the sequence control.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:WLNN:FBL1:MAC:SCON:STAT ON
activates the sequence control field.

Manual operation: See "Sequence Control" on page 56

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:STATe <State>

The command activates/deactivates the generation of the MAC Header.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:MAC:STAT ON
activates the generation of the MAC Header.

Manual operation: See "MAC Header" on page 54

6.8.3.2 MAC Header HT Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl.................................................. 138
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:ACConstraint.............................. 139
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CALibration:POSition...................139
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CALibration:SEQuence................139
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CSISteering................................ 140
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:FREQuest.................................. 140
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:HVINdicator?.............................. 141
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:LAControl................................... 141
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:NDP...........................................142
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:RDGMore...................................142
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:REServed...................................142
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:SREServed.................................142
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:STATe....................................... 143
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:ZLF............................................143

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl <HtControl>

The command sets the value for the HT control field.

Parameters:
<HtControl> integer

Range: #H00000000,32  to  #HFFFFFFFF,32
*RST: #H00000000,32
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Example: BB:WLNN:FBL1:MAC:HTC #H5a5a5a5a,32
sets the value for the HT control field.

Manual operation: See "HT/VHT Control" on page 65

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:ACConstraint
<AcConstraint>

The command sets the value for the AC signal field.

0 = The response may contain data from any TID (Traffic Identifier).

1 = The response may contain data only from the same AC as the last Data received
from the initiator.

Parameters:
<AcConstraint> integer

Range: #H0,1  to  #H1,1
*RST: 0

Example: BB:WLNN:FBL1:MAC:HTC:ACC #H0,1
sets the AC signal field to 0 (The response may contain data
from any TID)

Manual operation: See "AC Constraint" on page 65

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CALibration:POSition
<Position>

The command sets the value for the calibration position.

00 = Not a calibration frame (Default setting)

01 = Calibration Start

10 = Sounding Response

11 = Sounding Complete

Parameters:
<Position> integer

Range: #H0,2  to  #H3,2

Example: BB:WLNN:FBL1:MAC:HTC:CAL:POS #H0,2
sets the Calibration Position signal field to 00 (Not a calibration
frame).

Manual operation: See "Calibration Position" on page 66

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CALibration:SEQuence
<Sequence>

The command sets the value for the calibration sequence.
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Parameters:
<Sequence> integer

Range: #H0,2  to  #H3,2

Example: BB:WLNN:FBL1:MAC:HTC:CAL:SEQ #H3,2
sets the value for the calibration sequence.

Manual operation: See "Calibration Sequence" on page 66

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:CSISteering
<CsiSteering>

The command sets the value for the CSI steering.

00 = CSI

01 = uncompressed Steering Matrix

10 = compressed Steering Matrix

11 = Reserved

Parameters:
<CsiSteering> integer

Range: #H0,2  to  #H3,2

Example: BB:WLNN:FBL1:MAC:HTC:CSIS #H1,2
sets the value for the CSI steering to 01 (uncompressed Steer-
ing Matrix).

Manual operation: See "CSI Steering" on page 66

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:FREQuest <FRequest>

The command sets the value for the feedback request.

00 = no request

01 = unsolicited feedback only

10 = immediate feedback

11 = aggregated feedback

Parameters:
<FRequest> integer

Range: #H0,2  to  #H3,2

Example: BB:WLNN:FBL1:MAC:HTC:FREQ #H2,2
sets the value for the feedback request to 10 (immediate feed-
back).

Manual operation: See "Reserved" on page 66
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:HVINdicator?

The command queries the used format (HT or VHT).

Return values: 
<HTVHT> integer

Example: BB:WLNN:FBL:MAC:HTC:HVIN?
Response: 1
HT format is used.

Usage: Query only

Manual operation: See "HT/VHT" on page 67

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:LAControl <LaControl>

The command sets the value for the Link Adaption Control.

B0 (1bit) MA - MA payload

When the MA (Management Action) field is set to 1, the payload of the QoS Null Data
MPDU (Medium Access Controller Protocol Data Unit) is interpreted as a payload of
the management action frame.

B1 (1bit) TRQ - Sounding Request

1 = Request to the responder to transmit a sounding PPDU (Physical layer Protocol
Data Unit).

B2 (1bit) MRQ - MCS Request

1 = Request for feedback of MCS (Modulation Coding Scheme).

B3-B5 (3bit) MRS - MRQ Sequence Identifier

Set by sender to any value in the range '000'-'110' to identify MRQ. = Invalid if MRQ =
0

B6-B8 (3bit) MFS - MFB Sequence Identifier

Set to the received value of MRS. Set to '111' for unsolicited MFB.

B9-B15 (7bit) MFB - MCS Feedback

Link adaptation feedback containing the recommended MCS. When a responder is
unable to provide MCS feedback or the feedback is not available, the MFB is set to 'all-
ones' (default value) and also MFS is set to '1'.

Parameters:
<LaControl> integer

Range: #H0000,16  to  #HFFFF,16

Example: BB:WLNN:FBL1:MAC:HTC:LAC #H5A5A,16
sets the value for the Link AdaptionControl.

Manual operation: See "Link Adaption Control" on page 67
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:NDP <Ndp>

Sets the value of the Null Data Packet (NDP) announcement.

0 = no NDP will follow

1 = NDP will follow

Parameters:
<Ndp> integer

Example: BB:WLNN:FBL1:MAC:HTC:NDP #H1,1
sets the value for the NDP announcement to 1 (NDP will follow).

Manual operation: See "NDP Announcement" on page 66

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:RDGMore <RdgMore>

The command sets the value for the RDG/More PPDU.

Transmitted by Initiator

0 = No reverse grant.

1 = A reverse grant is present, as defined by the Duration/ID field.

Transmitted by Responder

0 = The PPDU carrying the MPDU is the last transmission by the responder.

1 = The PPDU carrying the frame is followed by another PPDU.

Parameters:
<RdgMore> integer

Range: #H0,1  to  #H1,1

Example: BB:WLNN:FBL1:MAC:HTC:RDGM #H0,1
sets the value for the RDG/More PPDU.

Manual operation: See "RDG/More PPDU" on page 65

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:REServed <Reserved>

This signal field is currently defined, but not used. It is set to zero by the transmitter
and ignored by the receiver.

Parameters:
<Reserved> integer

Range: #H0,5  to  #H5,2

Manual operation: See "Reserved" on page 65

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:SREServed <Reserved>

This signal field is currently defined, but not used.
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Parameters:
<Reserved> integer

Manual operation: See "Reserved" on page 66

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:STATe <State>

The command enables/disables HT Control.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:WLNN:FBL1:MAC:HTC:STAT ON
enables HT Control.

Manual operation: See "HT/VHT Control" on page 65

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:HTControl:ZLF <Zlf>

The command sets the value for the ZLF announcement.

0 = no ZLF will follow

1 = ZLF will follow

Parameters:
<Zlf> integer

Range: #H0,1  to  #H1,1

Example: BB:WLNN:FBL1:MAC:HTC:ZLF #H1,1
sets the value for the ZLF announcement to 1 (ZLF will follow).

Manual operation: See "NDP Announcement" on page 66

6.8.3.3 MAC Header VHT Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl................................................ 144
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:ACConstraint............................ 144
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:CTYPe.....................................144
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:FTTYpe....................................145
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:GIDH....................................... 145
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:HVINdicator?............................ 145
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MFB........................................ 146
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MGL........................................ 146
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MRQ........................................146
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MSI..........................................147
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:RDGMore.................................147
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:UMFB...................................... 147
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:VREServed.............................. 148
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl <VHTContol>

The command sets the value for the VHT control field.

Parameters:
<VHTContol> integer

Range: #H00000000,32  to  #HFFFFFFFF,32
*RST: #H00000000,32

Example: BB:WLNN:FBL1:MAC:VHTC #H5a5a5a5a,32
sets the value for the VHT control field.

Manual operation: See "HT/VHT Control" on page 65

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:ACConstraint
<VhtAcConstraint>

The command sets the value for the AC signal field. It indicates the access point of the
responder (1 bit).

Parameters:
<VhtAcConstraint> integer

0
The response may contain data from any TID (Traffic Identifier)
1
The response may contain data only from the same AC as the
last data received from the initiator.

Example: BB:WLNN:FBL:MAC:VHTC:ACC 0
the response may contain data from any TID.

Manual operation: See "AC Constraint" on page 68

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:CTYPe <CTYPe>

The command sets the coding information. If the Unsolicited MFB subfield is set to 1,
the Coding Type subfield contains the Coding information (set to 0 for BCC and set to
1 for LDPC) to which the unsolicited MFB refers.

Parameters:
<CTYPe> integer

0
BCC
1
LDPC

Example: BB:WLNN:FBL:MAC:VHTC:CTYP 1
sets the coding information for LPDC.

Manual operation: See "Coding Type" on page 68
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:FTTYpe <FbTxType>

The command sets the FB Tx Type subfield.

0 = If the Unsolicited MFB subfield is set to 1 and FB Tx Type subfield is set to 0, the
unsolicited MFB refers to either an unbeamformed VHT PPDU or transmit diversity
using an STBC VHT PPDU.

1 = If the Unsolicited MFB subfield is set to 1 and the FB Tx Type subfield is set to 1,
the unsolicited MFB refers to a beamformed SU-MIMO VHT PPDU.

Otherwise this subfield is reserved.

Parameters:
<FbTxType> integer

Example: BB:WLNN:FBL1:PAID:FTTY #B1,1
sets the FTTY subfield.

Manual operation: See "FB Tx Type" on page 68

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:GIDH <GIDH>

Sets GID-H subfield. If the Unsolicited MFB subfield is set to 1, the GID-H subfield con-
tains the highest 3 bits of Group ID of the PPDU to which the unsolicited MFB refers.

Otherwise this subfield is reserved.

Parameters:
<GIDH> integer

*RST: #H0

Example: BB:WLNN:FBL:MAC:VHTC:GIDH #B111,3
sets the coding information for GID-H.

Manual operation: See "GID-H" on page 69

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:HVINdicator?

The command queries the used format (HT or VHT).

Return values: 
<HtVhtIndicator> integer

Example: BB:WLNN:FBL:MAC:VHTC:HVIN?
Response: 1
VHT format is used.

Usage: Query only

Manual operation: See "HT/VHT" on page 70
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MFB <Mfb>

The command sets the MFB subfield. This subfield contains the recommended MFB.
The value of MCS=15 and VHT N_STS=7 indicates that no feedback is present.

See also Table 4-3 for definition of the MFB subfield.

Parameters:
<Mfb> integer

Example: BB:WLNN:FBL:MAC:VHTC:MFB #B111111111111111,15
sets the information for the MFB subfield.

Manual operation: See "MFB" on page 69

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MGL <MfsiGidL>

The command determines the information of the MFSI/GID-L subfield.

MFB = 0

If the Unsolicited MFB subfield is set to 0, the MFSI/GID-L subfield contains the
received value of MSI contained in the frame to which the MFB information refers.

MFB = 1

The MFSI/GID-L subfield contains the lowest 3 bits of Group ID of the PPDU to which
the unsolicited MFB refers.

Parameters:
<MfsiGidL> integer

Example: BB:WLNN:FBL:MAC:VHTC:MGL #B111,3
sets the information for the MFSI/GID-L subfield.

Manual operation: See "MFSI/GID-L" on page 69

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MRQ <Mrq>

The command determines the information of the MRQ subfield.

Parameters:
<Mrq> integer

0
requests MCS feedback (solicited MFB).
1
otherwise

Example: BB:WLNN:FBL:MAC:VHTC:MRQ #B1,1
sets the information for the MRQ subfield.

Manual operation: See "MRQ" on page 70
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:MSI <Msi>

The command sets the MSI subfield.

MRQ = 0

When the MRQ subfield is set to 0, the MSI subfield is reserved.

MRQ = 1

When the MRQ subfield is set to 1, the MSI subfield contains a sequence number in
the range 0 to 6 that identifies the specific request.

Parameters:
<Msi> integer

Example: BB:WLNN:FBL:MAC:VHTC:MSI #B111,3
sets the information for the MFSI/GID-L subfield.

Manual operation: See "MSI" on page 70

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:RDGMore
<VhtRdgMore>

The command issues the reverse direction grant. When transmitted by an initiator or a
responder, this field is interpreted differently.

Transmitted by Initiator

0 = No reverse grant.

1 = A reverse grant is present, as defined by the Duration/ID field.

Transmitted by Responder

0 = The PPDU carrying the MPDU is the last transmission by the responder.

1 = The PPDU carrying the frame is followed by another PPDU.

Parameters:
<VhtRdgMore> integer

Example: BB:WLNN:FBL:MAC:HTC #H80000000,32
BB:WLNN:FBL:MAC:VHTC:RDGM #B1,1
sets the value for the RDG/More PPDU.

Manual operation: See "RDG/More PPDU" on page 68

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:UMFB
<UnsolicitedMfb>

The command sets the Unsolicited MFB subfield.
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Parameters:
<UnsolicitedMfb> integer

0
if the MFB is a response to an MRQ.
1
if the MFB is not a response to an MRQ.

Example: BB:WLNN:FBL:MAC:VHTC:UMFB #B1,1
sets the information for the UMFB subfield.

Manual operation: See "Unsolicited MFB" on page 68

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:MAC:VHTControl:VREServed
<VhtReserved>

This signal field is currently defined, but not used. It is set to zero by the transmitter
and ignored by the receiver.

Parameters:
<VhtReserved> integer

Manual operation: See "Rsv" on page 70

6.8.4 Beacon Configuration

6.8.4.1 General Beacon Functions

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:BINTerval.................................. 148
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:DCCHannel?..............................149
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:IAWindow.................................. 149
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:SRATe...................................... 149
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:SSID......................................... 149
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:TSTamp.................................... 150

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:BINTerval <BInterval>

Defines the time intervall between two beacon transmissions.

Parameters:
<BInterval> float

Range: 0  to  65
Increment: 1E-9
*RST: 0.1
Default unit: s

Example: BB:WLNN:FBL1:BFC:BINT 200ms
Sets the time intervall between two beacon transmissions to 200
ms.

Manual operation: See "Beacon Interval" on page 59
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:DCCHannel?

Queries the current channel of the DSSS network.

Return values: 
<DCCHannel> integer

Example: BB:WLNN:FBL1:BFC:DCCH?

Usage: Query only

Manual operation: See "DSSS(Current Channel)" on page 60

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:IAWindow <IAWindow>

Sets the parameters necessary to support an IBSS (2 bytes). The Information field
contains the ATIM Window parameter.

Parameters:
<IAWindow> integer

*RST: #H0000

Example: BB:WLNN:FBL1:BFC:IAW #HFFFF,16

Manual operation: See "IBSS(ATIM Window) (hex)" on page 60

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:SRATe <SRATe>

Determines a set of data rates that are supported by the accesspoint (SupportedRates
field).

Parameters:
<SRATe> integer

Example: BB:WLNN:FBL1:BFC:SRAT #H06090C1218243036,64
Determines the following set of supported data rates: Hex num-
bers 06 09 0C 12 18 24 30 36.
This means: 6 Mbps, 9 Mbps, 12 Mbps, 18 Mbps, 24 Mbps, 36
Mbps, 48 Mbps and 54 Mbps are supported by the accesspoint.

Manual operation: See "SupportedRate" on page 60

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:SSID <Ssid>

Specifies the desired SSID or the wildcard SSID.

Parameters:
<Ssid> string

Range: 0 char  to  32 char

Example: BB:WLNN:FBL1:BFC:SSID "Rohde&Schwarz"
Sets the SSID to "Rohde&Schwarz".

Manual operation: See "SSID" on page 59
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:TSTamp <TStamp>

Sets the value of the TSF timer (Timing Synchronization Function of a frame’s source).

Parameters:
<TStamp> integer

Example: BB:WLNN:FBL1:BFC:TST #H1414AFAE891254BC, 64
Sets the value of the TSF timer to 1414AFAE891254BC.

Manual operation: See "Timestamp (hex)" on page 59

6.8.4.2 Capability Information Parameters

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:APSD........................ 150
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:CAGility..................... 151
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:CPOLlable................. 151
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:CPRequest................ 151
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:ESS...........................151
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:IBACk........................152
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:IBSS..........................152
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:DBACk...................... 152
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:DOFDm..................... 153
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:PBCC........................ 153
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:PRIVacy.................... 153
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:QOS..........................153
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:RMEasurement...........154
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:SMGMt...................... 154
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:SPReamble................154
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:SSTime......................155
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:HTCapability:GFIeld....................155
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:HTCapability:STATe................... 155

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:APSD
<CAPSd>

Informs the associated stations if automatic power save delivery (APSD, energy saving
function) is supported.

Parameters:
<CAPSd> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBLock1:BFC:CAP:APSD ON
Informs the associated stations that automatic power save deliv-
ery (APSD, energy saving function) is supported.

Manual operation: See "Capability Information Parameters" on page 61
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:CAGility
<CCAGility>

Informs the associated stations if channel agility is used.

Parameters:
<CCAGility> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:CAG ON

Manual operation: See "Capability Information Parameters" on page 61

Informs the associated stations that channel agility is used.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:CPOLlable
<CCPollable>

Informs the associated stations if contention free is pollable.

Parameters:
<CCPollable> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:CPOL ON
Informs the associated stations that contention free is pollable.

Manual operation: See "Capability Information Parameters" on page 61

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:CPRequest
<CCPRequest>

Indicates if contention free poll (CF-poll) is requested.

Parameters:
<CCPRequest> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:CPR ON
Tells the associated stations that contention free poll (CF-poll) is
requested.

Manual operation: See "Capability Information Parameters" on page 61

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:ESS
<CESS>

Informs the associated stations if the network is an ESS type network.

Parameters:
<CESS> 0 | 1 | OFF | ON

*RST: 1
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Example: BB:WLNN:FBL1:BFC:CAP:ESS ON
Informs the associated stations that the network is an ESS type
network.

Manual operation: See "Capability Information Parameters" on page 61

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:IBACk
<IBACk>

Informs the associated stations if immediate block Ack is allowed.

Parameters:
<IBACk> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:IBACk ON
Informs the associated stations that immediate block Ack is
allowed.

Manual operation: See "Capability Information Parameters" on page 61

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:IBSS
<CIBSs>

Informs the associated stations if the network is an IBSS type network.

Parameters:
<CIBSs> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:IBSS ON
Informs the associated stations that the network is an IBSS type
network.

Manual operation: See "Capability Information Parameters" on page 61

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:DBACk
<CDBAck>

Informs the associated stations if delayed block Ack is allowed.

Parameters:
<CDBAck> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:DBAC ON
Informs the associated stations that delayed block Ack is
allowed.

Manual operation: See "Capability Information Parameters" on page 61
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:DOFDm
<CDOFdm>

Indicates if Direct Sequence Spread Spectrum - OFDM is allowed.

Parameters:
<CDOFdm> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:DOFD

Manual operation: See "Capability Information Parameters" on page 61

Informs the associated stations that Direct Sequence Spread Spectrum - OFDM is
allowed.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:PBCC
<PBCC>

Informs the associated stations if PBCC is allowed.

Parameters:
<PBCC> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:PBCC ON

Manual operation: See "Capability Information Parameters" on page 61

Informs the associated stations that PBCC is allowed.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:PRIVacy
<PRIVacy>

Informs the associated stations if encryption is required for all data frames.

Parameters:
<PRIVacy> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:PRIV ON

Manual operation: See "Capability Information Parameters" on page 61

Informs the associated stations that encryption is required for all data frames.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:QOS
<QOS>

Informs the associated stations if quality of service (QoS) is supported.

Parameters:
<QOS> 0 | 1 | OFF | ON

*RST: 0
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Example: SOUR:BB:WLNN:FBL1:BFC:CAP:QOS ON
Informs the associated stations that quality of service (QoS) is
supported.

Manual operation: See "Capability Information Parameters" on page 61

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:
RMEasurement <RMEasurement>

Informs the associated stations if radio measurement is supported.

Parameters:
<RMEasurement> 0 | 1 | OFF | ON

*RST: 0

Example: SOUR:BB:WLNN:FBL1:BFC:CAP:RME ON

Manual operation: See "Capability Information Parameters" on page 61

Informs the associated stations that radio measurement is supported.

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:SMGMt
<SMGMt>

Informs the associated stations if spectrum management is enabled.

Parameters:
<SMGMt> 0 | 1 | OFF | ON

*RST: 0

Example: SOUR:BB:WLNN:FBL1:BFC:CAP:SMGM ON
Informs the associated stations that spectrum management is
enabled.

Manual operation: See "Capability Information Parameters" on page 61

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:SPReamble
<SPReamble>

Informs the associated stations if short preamble is allowed.

Parameters:
<SPReamble> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAP:SPR ON

Manual operation: See "Capability Information Parameters" on page 61

Informs the associated stations that short preamble is allowed.
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:CAPability:SSTime
<SSTime>

Informs the associated stations if short slot time is supported.

Parameters:
<SSTime> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:CAPability:SST ON
Informs the associated stations that short slot time is supported.

Manual operation: See "Capability Information Parameters" on page 61

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:HTCapability:GFIeld
<GreenField>

Enables/disables the support for the reception of PPDUs with HT Greenfield format.

Parameters:
<GreenField> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "Green Field" on page 63

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:HTCapability:STATe
<State>

Activates/ deactivates the HT capability information element.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "State" on page 63

6.8.4.3 ERP Parameters

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:ERP:BPMode.............................155
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:ERP:NEPResent........................ 156
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:ERP:UPRotection....................... 156

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:ERP:BPMode
<EBPMode>

Informs associated stations whether to use the long or the short preamble.

Parameters:
<EBPMode> 0 | 1 | OFF | ON

*RST: 0
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Example: BB:WLNN:FBL1:BFC:ERP:BPM ON
Informs associated stations that they should use the long pream-
ble.

Manual operation: See "ERP Parameters" on page 63

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:ERP:NEPResent
<ENEPresent>

Sets Non-ERP Present on. This is needed if there is a non-ERP MU associated to the
AP.

Parameters:
<ENEPresent> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:ERP:NEPR ON
Sets on Non-ERP Present.

Manual operation: See "ERP Parameters" on page 63

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:BFConfiguration:ERP:UPRotection
<EUPRotection>

Informs associated stations if they have to use protection.

Parameters:
<EUPRotection> 0 | 1 | OFF | ON

*RST: 0

Example: BB:WLNN:FBL1:BFC:ERP:UPR ON
Informs associated stations that they have to use protection.

Manual operation: See "ERP Parameters" on page 63

6.8.5 Spatial Mapping Configuration

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:MODE............................................... 156
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:BSELection........................................ 157
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:TSHift<st>..........................................158
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:INDex................................................ 158
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:ROW<st>:COL<dir>:I?........................ 158
[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:ROW<st>:COL<dir>:Q?.......................159

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:MODE <Mode>

The command selects the spatial mapping mode for the selected frame block. Except
of the Beamforming mode, the matrix element values are loaded through the use of
Info Class Methods.
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Parameters:
<Mode> OFF | DIRect | EXPansion | BEAMforming | INDirect

OFF
(only "LEGACY" mode)
The spatial mapping mode is switched off automatically.
DIRect
(only active with physical modes MIXED MODE or GREEN
FIELD when NTX = NSTS)
The transmit matrix is a CSD matrix, that is, diagonal matrix of
unit magnitude and complex values that represent cyclic shifts in
the time domain.
EXPansion
(only active with physical modes MIXED MODE or GREEN
FIELD)
The transmit matrix is the product of a CSD matrix and a square
matrix formed of othogonal colums, as defined in the IEEE
802.11n specification.
BEAMforming
(this feature will be supported in further release)
The transmit matrix is the product of a CSD matrix and the
Hadamard unitary matrix.
The File button is displayed to open a Browse popup. A file with
source format *.bmf can be selected for the beamforming. The
file must include 128 4*4 IQ elements (corresponding to the sub-
carriers).
INDirect
(only active with physical modes MIXED MODE or GREEN
FIELD)
The transmit matrix is the product of a CSD matrix and the
Hadamard unitary matrix.
*RST: EXPansion

Example: BB:WLNN:FBL1:SMAP:MODE OFF
sets the spatial mapping mode to OFF, that is, the spatial map-
ping mode is switched off automatically.

Manual operation: See "Mode" on page 71

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:BSELection <BSelection>

The command loads the selected file for beamforming.

Parameters:
<BSelection> string

Example: BB:WLNN:FBL1:PMOD MIX
BB:WLNN:FBL1:SMAP:MODE BEAM
BB:WLNN:FBL1:SMAP:BSEL
'/var/user/temp/test_scpi.bmf'
loads the selected file for beamforming.
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Manual operation: See "Mode" on page 71

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:TSHift<st> <TShift>

The command sets the spatial mapping time shift. This value is relevant for spatial
mapping mode Direct and Spatial Expansion only.

Parameters:
<TShift> float

Range: -32000 ns  to  32000 ns
Increment: 1 ns
*RST: 0 ns

Example: BB:WLNN:FBL1:SMAP:MODE TSH 1000
sets the spatial mapping time shift to 1000 ns.

Manual operation: See "Time Shift" on page 72

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:INDex <Index>

Sets the index of the sub-carrier. A matrix is mapped to each sub-carrier. With the
exception of k=0, the index can be set in the value range of -64 to 63

Parameters:
<Index> integer

Range: depends on TxMode  to  depends on TxMode
*RST: 20

Example: BB:WLNN:FBL1:SMAP:IND 30
sets the index of the sub-carrier to k = 30.

Manual operation: See "Index k" on page 72

[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:ROW<st>:COL<dir>:I?

Queries the time shift value of element I of the selected row and column of the spatial
transmit matrix.

Suffix: 
<st>

.
[1] .. 8

<dir> [1] .. 8

Return values: 
<I> float

Example: BB:WLNN:FBL1:SMAP:ROW2:COL2:I?
queries the time shift value of element I for row 2, column 2.

Usage: Query only

Manual operation: See "I (Transmit Matrix)" on page 73
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[:SOURce<hw>]:BB:WLNN:FBLock<ch>:SMAPping:ROW<st>:COL<dir>:Q?

Queries the time shift value of element Q of the selected row and column of the spatial
transmit matrix.

Suffix: 
<st>

.
[1] .. 8

<dir> [1] .. 8

Return values: 
<Q> float

Example: BB:WLNN:FBL1:SMAP:ROW2:COL2:Q?
queries the time shift value of element Q for row 2, column 2.

Usage: Query only

Manual operation: See "Q (Transmit Matrix)" on page 73
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List of Commands
[:SOURce<hw>]:BB:WLNN:ANTenna:MODE................................................................................................108
[:SOURce<hw>]:BB:WLNN:ANTenna:SYSTem............................................................................................108
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:DESTination...................................................109
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:OUTPut:FSELect......................................................... 109
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:IMAGinary...................................................... 110
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:MAGNitude.....................................................110
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:PHASe............................................................110
[:SOURce<hw>]:BB:WLNN:ANTenna:TCHain<ch>:TX<dir>:REAL..............................................................110
[:SOURce<hw>]:BB:WLNN:BWidth.................................................................................................................86
[:SOURce<hw>]:BB:WLNN:CFBLock..............................................................................................................87
[:SOURce<hw>]:BB:WLNN:CLIPping:LEVel................................................................................................... 90
[:SOURce<hw>]:BB:WLNN:CLIPping:MODE..................................................................................................90
[:SOURce<hw>]:BB:WLNN:CLIPping:STATe..................................................................................................91
[:SOURce<hw>]:BB:WLNN:CLOCk:MODE...................................................................................................107
[:SOURce<hw>]:BB:WLNN:CLOCk:MULTiplier............................................................................................ 107
[:SOURce<hw>]:BB:WLNN:CLOCk:SOURce................................................................................................107
[:SOURce<hw>]:BB:WLNN:DFBLock..............................................................................................................87
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